Copyright © ShenZhen Yuejiang Technology Co., Ltd 2018. All rights reserved.

No part of this document may be reproduced or transmitted in any form or by any means without prior written consent of Yuejiang Technology Co., Ltd

Disclaimer

To the maximum extent permitted by applicable law, the products described (including its hardware, software and firmware, etc.) in this document are provided AS IS, which may have flaws, errors or faults. Yuejiang makes no warranties of any kind, express or implied, including but not limited to, merchantability, satisfaction of quality, fitness for a particular purpose and non-infringement of third party rights. In no event will Yuejiang be liable for any special, incidental, consequential or indirect damages resulting from the use of our products and documents.

Before using our product, please thoroughly read and understand the contents of this document and related technical documents that are published online, to ensure that the robotic arm is used on the premise of fully understanding the robotic arm and related knowledge. Please use this document with technical guidance from professionals. Even if follow this document or any other related instructions, Damages or losses will be happen in the using process, Dobot shall not be considered as a guarantee regarding to all security information contained in this document.

The user has the responsibility to make sure following the relevant practical laws and regulations of the country, in order that there is no significant danger in the use of the robotic arm.

Shenzhen Yuejiang Technology Co., Ltd

Address: 3F, Building NO.3, Tongfuyu Industrial Town, Nanshan District, Shenzhen, China
Website: www.dobot.cc
Preface

Purpose

This Document describes the functions, technical specifications, installation guide and system commissioning of Dobot Magician, making it easy for users to fully understand and use it.

Intended Audience

This document is intended for:

- Customer Engineer
- Sales Engineer
- Installation and Commissioning Engineer
- Technical Support Engineer

Change History

<table>
<thead>
<tr>
<th>Date</th>
<th>Change Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018/09/11</td>
<td>Updated the connection figure between Dobot Magician and sliding rail</td>
</tr>
<tr>
<td>2018/06/12</td>
<td>The first release</td>
</tr>
</tbody>
</table>

Symbol Conventions

The symbols that may be founded in this document are defined as follows.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️ DANGER</td>
<td>Indicates a hazard with a high level of risk which, if not avoided, could result in death or serious injury</td>
</tr>
<tr>
<td>⚠️ WARNING</td>
<td>Indicates a hazard with a medium level or low level of risk which, if not avoided, could result in minor or moderate injury, robotic arm damage</td>
</tr>
<tr>
<td>⚠️ NOTICE</td>
<td>Indicates a potentially hazardous situation which, if not avoided, can result in robotic arm damage, data loss, or unanticipated result</td>
</tr>
<tr>
<td>☠️ NOTE</td>
<td>Provides additional information to emphasize or supplement important points in the main text</td>
</tr>
</tbody>
</table>
Contents

1. Security Precautions .............................................................................................................. 1
   1.1 General Security ........................................................................................................... 1
   1.2 Precautions .................................................................................................................. 2

2. Quick Start ............................................................................................................................ 4
   2.1 Connecting Cables to the Dobot Magician ................................................................. 4
   2.2 Installing the DobotStudio .......................................................................................... 5
       2.2.1 System Requirements ....................................................................................... 5
       2.2.2 Obtaining the DobotStudio Package ............................................................... 6
       2.2.3 Installing the DobotStudio .............................................................................. 6
       2.2.4 Verifying the Installation ................................................................................. 8
   2.3 Powering On/Off the Dobot Magician ....................................................................... 10
   2.4 Getting Started ............................................................................................................ 11

3. Introduction .......................................................................................................................... 19
   3.1 Overview ....................................................................................................................... 19
   3.2 Appearance and Constitute ......................................................................................... 19
   3.3 Working Principle ...................................................................................................... 19
       3.3.1 Workspace ......................................................................................................... 19
       3.3.2 Coordinate System ........................................................................................... 21
       3.3.3 Motion Function ............................................................................................... 22
   3.4 Technical Specifications ............................................................................................ 24
       3.4.1 Technical Parameters ....................................................................................... 24
       3.4.2 Sizes .................................................................................................................. 25

4. Interface Description ............................................................................................................ 27
   4.1 Interface Board ............................................................................................................. 27
   4.2 LED Indicator .............................................................................................................. 29
   4.3 Multiplexed I/O Interface Description ..................................................................... 29
       4.3.1 Multiplexed Base I/O Interface Description ...................................................... 29
       4.3.2 Multiplexed Forearm I/O Interface Description ............................................... 31

5. Operation .............................................................................................................................. 33
   5.1 Introduction to the DobotStudio ............................................................................... 33
       5.1.1 Function Modules .............................................................................................. 33
       5.1.2 Common Areas of DobotStudio Page ............................................................... 35
   5.2 Performing Teaching & Playback Tasks .................................................................... 37
       5.2.1 Installing a Suction Cup Kit ............................................................................... 37
       5.2.2 Installing a Gripper Kit ..................................................................................... 40
       5.2.3 Teaching & Playback Page ............................................................................... 42
       5.2.4 ARC Motion Mode ............................................................................................ 45
       5.2.5 Teaching & Playback Example ....................................................................... 48
   5.3 Working in Offline Mode ............................................................................................. 54
   5.4 Writing and Drawing ................................................................................................... 56
       5.4.1 Installing a Writing and drawing kit ................................................................. 56
       5.4.2 Connecting the DobotStudio ............................................................................ 57
1. Security Precautions

This topic describes the security precautions that should be noticed when using this product. Please read this document carefully before using the robotic arm for the first time. This product need to be carried out in an environment meeting design specifications, you cannot remold the product without authorization, otherwise it could lead to product failure, and even personal injury, electric shock, fire, etc. The installation personnel, operators, teaching personnel, and programmers of the robotic arm must read this document carefully and use the robotic arm strictly according to the regulations of this document strictly.

1.1 General Security

⚠️ DANGER

Robotic arm is an electrical equipment. Non-professional technicians cannot modify the wire, otherwise it is vulnerable to injury the device or the person.

The following security rules should be followed when using the robotic arm.

- You should comply with local laws and regulations when operating the robotic arm. The security precautions in this document are only supplemental to local laws and regulations.
- The **DANGER**, **WARNING**, and **NOTICE** marks in this document are only supplemental to the security precautions.
- Please use the robotic arm in the specified environment scope. If not, exceeding the specifications and load conditions will shorten the service life of the product even damage the equipment.
- Before operating and maintaining the robotic arm, the personnel responsible for the installation, operation and maintenance must be trained to understand the various security precautions and to master the correct methods of operation and maintenance.
- Highly corrosive cleaning is not suited to cleaning the robotic arm. The anodized components are not suitable for immersion cleaning.
- People cannot repair and disassemble the robotic arm without professional training. If there is a problem with the robotic arm, please contact Dobot technical support engineer in time.
- Please comply with the relevant laws to deal with the product which is scrapped, and protect the environment.
- There are small parts in the packing box, Please keep them away from children, to avoid any accidents.
- DO NOT let children play with the robotic arm alone. All processes need to be monitored while running. After processes have finished, please turn off the equipment promptly.
- DO NOT put hands into the workspace of the robotic arm while running, to avoid
bruising or pinching.

- Be careful during the robotic arm carrying or installing. Please follow the instructions on the packing box to put down the robotic arm gently and place it correctly in direction of arrow.
- Commissioning of the incomplete machine is prohibited until it has been installed in a machine and the whole machine complies with the provisions of the Machinery Directive (2006/42/EC).
- It is prohibited to modify or remove the nameplates, instructions, icons and marks on the robotic arm and the related equipment.
- Please refer to Dobot Magician User Guide along with the packing box before using.

1.2 Precautions

- Please make the Dobot Magician in the workspace with a 45° angle between the Forearm and Rear Arm (as shown in Figure 1.1) before starting up. If the LED indicator turns red after starting up, it indicates that the Dobot Magician is at a limited position. Please make the Dobot Magician in the workspace.

![Figure 1.1 The Forearm and Rear Arm position](image)

- Dobot Magician will move slowly to the specific position when shutdown. DO NOT put hands into the workspace of the Dobot while running, to avoid bruising or pinching. Only once the LED indicator completely turns off, the Dobot Magician can be powered down.
- If the coordinates of the Dobot Magician shown on the DobotStudio are abnormal, please press the Reset button on the back of the base to reset Dobot Magician or click Home on the DobotStudio page to perform homing.
- During resetting, Dobot Magician will disconnect from the PC automatically and the LED indicator on the base turns yellow. About 5 seconds later, if the LED indicator turns green, it indicates that the reset is successful.
- During homing, Dobot Magician will rotate clockwise to the limited position and then return to the homing point automatically, and the LED indicator on the base turns blue and is blinking. After homing, if there is a beep sound and the LED indicator turns green, it indicates that the homing is successful.
• Please turn off the Dobot Magician completely first before connecting or disconnecting external equipment, such as Bluetooth, WIFI, stick controller, infrared sensor, color sensor, etc. Or, it causes damage to your device.

• Please wear the lasing protective eyeglass when using the laser module. Please protect your eyes and skin from the laser.

• The heating rod will produce high temperature up to 250°C when using the 3D printing module, please be careful.

• Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid machine damage.
2. Quick Start

This topic briefly describes how to operate the Dobot Magician with the software DobotStudio, allowing you to quickly know and use the robotic arm. Figure 2.1 shows the process of getting started with the Dobot Magician.

![Diagram of process](image)

Figure 2.1  The process of getting started with the Dobot Magician

2.1 Connecting Cables to the Dobot Magician

**Step 1**  Connect the Dobot Magician to your computer with the supplied USB cable, as shown in Figure 2.2.
Step 2  Connect the Dobot Magician to the electrical outlet with the supplied power adapter, as shown in Figure 2.3.

![Figure 2.3 Connect the Dobot Magician to the electrical outlet](image)

2.2 Installing the DobotStudio

You can control Dobot Magician by DobotStudio to implement functions such as Teaching & Playback, fully programmable applications, and 3D printing. This topic introduces Teaching & Playback.

2.2.1 System Requirements

The DobotStudio supports the following Windows and macOS versions.

- Windows 7, Windows 8, and Windows 10 (This manual is explained based on this version)
2.2.2 Obtaining the DobotStudio Package

Before using Dobot Magician, download the Windows DobotStudio package from https://www.dobot.cc/downloadcenter.html. The macOS version is also downloadable in this URL.

2.2.3 Installing the DobotStudio

Prerequisites

The DobotStudio package has been obtained.

Procedure

Step 1 Unpack the DobotStudio package to a destination directory.

For example, this directory is `Installation Directory\DobotStudio`. You can install the DobotStudio to another location based on site requirements.

Step 2 In the installation directory double-click `DobotStudioSetup.exe`. The Select Setup Language dialog box is displayed, as shown in Figure 2.4.

![Figure 2.4 The Select Setup Language dialog box](image)

Step 3 Choose a setup language such as **English**, as shown in Figure 2.5. You can also select **Chinese** if needed.

![Figure 2.5 Select English](image)

Step 4 Click **OK** to follow the on-screen instructions to continue with the installation.

During the installation, the Driver Installation dialog box is displayed. Two drivers need to be installed, as shown in Figure 2.6.
Step 5  Click Next to install the first driver, and then click INSTALL to install the second driver.

When the drivers are installed successfully, the Completing the Device Driver Installation Wizard dialog box is displayed. Click Finish, as shown in Figure 2.7.

Step 6  Click Next to continue to install the DobotStudio by following the prompts on the Setup – DobotStudio dialog box.

When the installation is complete, the Completing the DobotStudio Setup Wizard dialog box is displayed. Click Finish, as shown in Figure 2.8.
Step 3  Click **Finish**.

2.2.4  Verifying the Installation

2.2.4.1  Verifying the DobotStudio

If the DobotStudio is launched and runs properly by double-clicking the desktop shortcut to this program, it means that it is installed successfully.

2.2.4.2  Verifying the Dobot Magician Driver

If an available COM port is displayed on the upper left corner of the DobotStudio page after the robotic arm is powered on, as shown in Figure 2.9, the Dobot Magician driver is installed successfully.

![Figure 2.9  An available COM port is displayed](image)

If no COM port is available, check whether the robotic arm driver is successfully installed by following the steps below.

**Step 1**  Connect the Dobot Magician to your computer with the supplied USB cable.

**Step 2**  Press the power button to apply power.
Step 3  Launch the Device Manager window to locate the Ports (COM & LPT) section. If the item Silicon Labs CP210x USB to UART Bridge (COM6) or USB-SERIAL CH340(COM3) is displayed, it means the Dobot Magician driver is installed successfully.

![Device Manager](image)

**Figure 2.10** The V2 robotic arm driver in Device Manager window

![Device Manager](image)

**Figure 2.11** The V1 robotic arm driver in Device Manager window

**NOTE**

- To reinstall the Dobot Magician driver after uninstalling it, install the driver corresponding to the Windows version in the directory `Installation Directory\DobotStudio\attachment\Drive\HardwareV1.0.0`. For example, install the 64-bit driver on a 64-bit Windows 10, as shown in Figure 2.12.
Figure 2.12 Install the 64-bit driver on a 64-bit Windows 10

- If the DobotStudio hardware version is 0.0.0, install the driver matching the Windows version in the directory:
  
  \[\text{Installation Directory}\DobotStudio\attachment\Drive\HardwareV0.0.0.\]

  Please connect the DobotStudio to the robotic arm and then click \[\text{to check the hardware version.}\]

2.3 Powering On/Off the Dobot Magician

- **Power on**: align the Dobot Magician into its neutral position with its Forearm and Rear Arm constructing a 45-degree angle, and press down the power button in the base, as shown in Figure 2.13. Once the robotic arm is powered on, the LED indicator turns yellow, and all the stepper motors lock. And then wait about seven seconds, a short beep sound will be heard, and the LED indicator turns from yellow to green. Now the Dobot Magician is ready to use.

⚠️ **NOTICE**

If the LED indicator is red after powering on the Dobot Magician, it means that the robotic arm reaches its limited position. To go back to the workspace, press and hold the unlock button \[\text{on the Forearm to move the robotic arm to another desired position.}\] After releasing the button the LED indicator turns green.
Figure 2.13  The gesture of Dobot Magician before power-on

- **Power off**: When the LED indicator is green, press down the power button to turn off the robotic arm. In this case, the Forearm moves slowly to the Rear Arm while the angle between them becomes small. Finally, the two arms reach a specific position.

⚠️ **WARNING**

During the shutdown process, watch your hand.

## 2.4 Getting Started

This topic describes how to use the Dobot Magician to complete the teaching & playback function by saving three points in the MOVJ mode, allowing you to get the basic knowledge of the usage of the robotic arm.

### Prerequisites

- The DobotStudio has been installed. For details, see 2.2 Installing the DobotStudio.
- The Dobot Magician is powered on. For details, see 2.3 Powering On/Off the Dobot Magician.

### Procedure

**Step 1**  Double-click the desktop shortcut to the DobotStudio.

The DobotStudio page with its beginner guide is displayed, as shown in Figure 2.14.
NOTE

After reading the beginner guide of the DobotStudio, click to close it.

Step 2  Click Connect on the DobotStudio page, as shown in Figure 2.15. The Question dialog box is displayed, as shown in Figure 2.16.
Step 3 Click Link Now.

Because this section is for quick access to the Dobot Magician only and no high accuracy is required.

When Connect changes to Disconnect, it means that the DobotStudio is connected to the Dobot Magician, as shown in Figure 2.17.

NOTE
To achieve a high accuracy of the robotic arm, click Wait Link.

Step 4 Use DobotStudio to accomplish a teaching & playback task.

1. Click Teaching & Playback, as shown in Figure 2.18.
NOTE

After reading a beginner guide on the Teaching & Playback page, as shown in Figure 2.19, click × to close it.

2. Select PTP Point > MOVJ mode in the Save Point area, as shown in Figure 2.20.
3. Press and hold the unlock button on the Forearm to move the robotic arm to a position such as point A, and then release the button. In this case, the DobotStudio will save the Cartesian coordinate of point A, as shown in Figure 2.21.

![Figure 2.20 Select MOVJ motion mode](image)

![Figure 2.21 The Cartesian coordinate of point A](image)

**NOTE:**
Apart from hand-guided teaching, you can accomplish a teaching task by jogging the Dobot Magician in the Cartesian or Joint coordinate system, as shown in Figure 2.22.
Figure 2.22  Jog the Dobot Magician in the Cartesian or Joint coordinate system

4. Move the robotic arm to other two locations such as points B and C by referring to the method of creating point A above, as shown in Figure 2.23. The robotic arm will save the Cartesian coordinates corresponding to these two points.

Figure 2.23  The Cartesian coordinates of points B and C

5. Enter 3 in **Loop** text box.
   The robotic arm will repeat the sequence of movements for three times, as shown in Figure 2.24.
6. Click **Start** to perform the motions taught above, as shown in Figure 2.25. The robotic arm will stop after playing back the steps for three times.

7. Click **Edit** to exit the **Teaching & Playback** page, as shown in Figure 2.26.
Figure 2.26  Click Exit
3. Introduction

3.1 Overview

Dobot Magician is a multifunctional desktop robotic arm for practical training education, supporting teaching and playback, blockly graphic programming, script, etc. Installed with different end-effectors, Dobot Magician can realize interesting functions such as 3D printing, laser engraving, writing and drawing. It also supports secondary development by various extensible I/O interfaces, which really makes your creativity and imagination increase without any limitation.

3.2 Appearance and Constitute

Dobot Magician consists of Abase, Rear Arm, Forearm, and end-effector, etc. Figure 3.1 shows the appearance.

![Figure 3.1 The appearance of Dobot Magician](image)

3.3 Working Principle

This topic describes the workspace, principle, size and technical specifications of Dobot Magician.

3.3.1 Workspace

Figure 3.2 and Figure 3.3 shows the workspace.
Figure 3.2  Workspace of Dobot Magician (1)

Figure 3.3  Workspace of Dobot Magician (2)
3.3.2 Coordinate System

Dobot Magician has two types of coordinate system, the joint one and the Cartesian one, as shown in Figure 3.4 and Figure 3.5 respectively.

- **Joint coordinate system**: The coordinates are determined by the motion joints.
- If the end-effector is not installed, Dobot Magician contains three joints: J1, J2, and J3, which are all the rotating joints. The positive direction of these joints is counter-clockwise.
- If the end-effector with servo is installed, such as suction cup kit, gripper kit, Dobot Magician contains four joints: J1, J2, J3 and J4, which are all the rotating joints. The positive direction of these joints is counter-clockwise.
- **Cartesian coordinate system**: The coordinates are determined by the base.
- The origin is the center of the three motors (Rear Arm, Forearm, base).
- The direction of X-axis is perpendicular to the base forward.
The direction of Y-axis is perpendicular to the base leftward.

The direction of Z-axis is vertical upward, which is based on the right hand rule.

The R-axis is the attitude of the servo center relative to the origin of the robotic arm, of which the positive direction is counter-clockwise. The R-axis only exists once the end-effector with servo is installed.

### 3.3.3 Motion Function

The motion modes of Dobot Magician include Jogging, Point to Point (PTP), ARC.

#### 3.3.3.1 Jogging Mode

Jogging mode is the mode jogging Dobot Magician along the Cartesian coordinate system or Joint coordinate system when teaching.

⚠️ **NOTE**

This topic describes jogging mode by the GUI operation of DobotStudio.

- Cartesian coordinate system mode
  - Click X+, X- and Dobot Magician will move along X-axis in the negative or positive direction.
  - Click Y+, Y- and Dobot Magician will move along Y-axis in the negative or positive direction.
  - Click Z+, Z- and Dobot Magician will move along Z-axis in the negative or positive direction.
  - Click R+, R- and Dobot Magician will rotate along R-axis in the positive or negative direction.

⚠️ **NOTICE**

If the end-effector with servo is installed on the Dobot Magician, the R-axis will move together with Y-axis, to make sure that the terminal posture relative to the origin stays constant.

- Joint coordinate system mode
  - Click J1+, J1- and control the base motor to rotate in the negative or positive direction.
  - Click J2+, J2- and control the Rear Arm motor to rotate in the negative or positive direction.
  - Click J3+, J3- and control the Forearm motor to rotate in the negative or positive direction.
  - Click J4+, J4- and control the servo to rotate in the negative or positive direction.

#### 3.3.3.2 Point to Point (PTP)

PTP mode supports MOVJ, MOVL, and JUMP, which means point to point movement. The trajectory of playback depends on the motion mode.
• MOVJ: Joint movement. From point A to point B, each joint will run from initial angle to its target angle, regardless of the trajectory, as shown in Figure 3.6.

![Figure 3.6 MOVL/MOVJ mode](image)

• MOVL: Rectilinear movement. The joints will perform a straight line trajectory from point A to point B, as shown in Figure 3.6.

• JUMP: From point A to point B, the joints will move in MOVJ mode, of which the trajectory looks like a door, as shown in Figure 3.7.
  1. Move up the lifting Height in MOVJ mode.
  2. Move horizontally to a point that is above B by height.
  3. Move down to point B.

![Figure 3.7 JUMP mode](image)

3.3.3.3 ARC

The trajectory of ARC mode is an arc, which is determined by three points (the current point, any point and the end point on the arc), as shown in Figure 3.8.

⚠️ NOTICE

In ARC mode, it is necessary to confirm the three points with other motion modes, and the three points cannot be in a line.
3.3.3.4 Application Scenarios

The application scenario depends on the trajectory in motion mode, as shown in Table 3.1.

Table 3.1 Application scenario

<table>
<thead>
<tr>
<th>Motion mode</th>
<th>Application scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOVL</td>
<td>If the trajectory of playback is required as a straight line, you can choose MOVL</td>
</tr>
<tr>
<td>MOVJ</td>
<td>If the trajectory of playback is not required but high speed is required, you can choose MOVJ</td>
</tr>
<tr>
<td>JUMP</td>
<td>If the movement of two points is required to lift upwards by amount of height, such as sucking up, grabbing, you can choose JUMP</td>
</tr>
<tr>
<td>ARC</td>
<td>If the trajectory of playback is required as an arc, such as dispensing, you can choose ARC</td>
</tr>
</tbody>
</table>

3.4 Technical Specifications

3.4.1 Technical Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Dobot Magician</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum payload</td>
<td>500g</td>
</tr>
<tr>
<td>Maximum reach</td>
<td>320mm</td>
</tr>
<tr>
<td>Motion range</td>
<td></td>
</tr>
<tr>
<td>Base</td>
<td>- 90°~+90°</td>
</tr>
<tr>
<td>Rear Arm</td>
<td>0°~85°</td>
</tr>
<tr>
<td>Forearm</td>
<td>- 10°~+90°</td>
</tr>
<tr>
<td>End-effector rotation</td>
<td>- 90°~+90°</td>
</tr>
<tr>
<td><strong>Maximum speed (with 250g payload)</strong></td>
<td>Rotational speed of Rear arm, Forearm and base</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Repeated positioning accuracy</td>
<td>Rotational speed of servo</td>
</tr>
<tr>
<td>Power supply</td>
<td>100V-240V AC, 50/60Hz</td>
</tr>
<tr>
<td>Power in</td>
<td>12V/7A DC</td>
</tr>
<tr>
<td>Communication</td>
<td>USB, WIFI, Bluetooth</td>
</tr>
<tr>
<td>I/O</td>
<td>20 extensible I/O interfaces</td>
</tr>
<tr>
<td>Software</td>
<td>DobotStudio</td>
</tr>
<tr>
<td>Working temperature</td>
<td>-10°C~60°C</td>
</tr>
</tbody>
</table>

### 3.4.2 Sizes

Figure 3.9 shows the size of Dobot Magician and Figure 3.10 shows the size of the end mounting hole.
Figure 3.9  Size of Dobot Magician

Figure 3.10  Size of end mounting hole
4. Interface Description

4.1 Interface Board

The interfaces of Dobot Magician are located on the back of the base and the Forearm respectively. Figure 4.1 shows the interfaces on the back of the base, and Table 4.1 lists the description.

![Figure 4.1 Interfaces in the base](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1   | Reset key: Reset MCU program  
During resetting, the LED indicator on the base turns yellow. About 5 seconds later, if the LED indicator turns green, it indicates that the reset is successful |
| 2   | Functional key:  
• Short press: Start running offline program  
• Long press for 2 seconds: Starting homing procedure |
| 3   | Communication interface/UART interface: Connect with Bluetooth, WIFI and so on  
The Dobot protocol is adopted. |
| 4   | USB interface: Connect with PC |
| 5   | Power interface: Connect with power adaptor |
| 6   | Peripheral interface: Connect with air pump, extruder, sensor and other peripheral equipment. For details about peripheral interfaces, please see Table 4.2 |

Table 4.2 lists the peripheral interface description.
Table 4.2 Peripheral interface description

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1</td>
<td>Power interface of air pump; output 12V of controllable power</td>
</tr>
<tr>
<td>SW2</td>
<td>Output 12V of controllable power</td>
</tr>
<tr>
<td>Stepper1</td>
<td>User-defined stepper interface; extruder interface (3D printing mode)</td>
</tr>
<tr>
<td>Stepper2</td>
<td>User-defined stepper interface</td>
</tr>
<tr>
<td>GP1</td>
<td>Signal interface of air pump; color sensor interface; infrared sensor interface; user-defined general interface</td>
</tr>
<tr>
<td>GP2</td>
<td>User-defined general interface</td>
</tr>
</tbody>
</table>

Figure 4.2 shows the peripheral interface on the Forearm, and Table 4.3 lists the description of the peripheral interfaces.

![Peripheral interface in the Forearm](image)

Figure 4.2 Peripheral interface in the Forearm

Table 4.3 Peripheral interface description

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GP3, End-effector interface; R-axis servo interface; user-defined general interface</td>
</tr>
<tr>
<td>2</td>
<td>GP4, Auto levelling interface, user-defined general interface</td>
</tr>
<tr>
<td>3</td>
<td>GP5, Signal interface of laser engraving; user-defined general interface</td>
</tr>
<tr>
<td>4</td>
<td>SW3, Hot end interface (3D printing mode); Output 12V of controllable power</td>
</tr>
<tr>
<td>5</td>
<td>SW4, Fan interface (3D printing mode); Power interface of laser engraving; Output 12V of controllable power</td>
</tr>
<tr>
<td>6</td>
<td>ANALOG, Thermistor interface (3D printing mode)</td>
</tr>
</tbody>
</table>
4.2 LED Indicator

The LED indicator is located on the base, Table 4.4 lists the status description.

Table 4.4 LED indicator description

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green On</td>
<td>Dobot Magician works normally</td>
</tr>
<tr>
<td>Yellow On</td>
<td>Dobot Magician is in the starting status</td>
</tr>
<tr>
<td>Blue On</td>
<td>Dobot Magician is in the offline mode</td>
</tr>
<tr>
<td>Blue Blinking</td>
<td>Dobot Magician is running homing procedure or auto levelling</td>
</tr>
<tr>
<td>Red On</td>
<td>• Dobot Magician is at the limited position</td>
</tr>
<tr>
<td></td>
<td>• Alarm is not cleared</td>
</tr>
<tr>
<td></td>
<td>• Connection of 3D printing kit is abnormal</td>
</tr>
</tbody>
</table>

4.3 Multiplexed I/O Interface Description

The addresses of the I/O interfaces in Dobot Magician are unified. Most of I/O interfaces have multiple functions, to control the peripheral equipment.

4.3.1 Multiplexed Base I/O Interface Description

4.3.1.1 Multiplexed UART Interface Description

Figure 4.3 shows the UART interface on the base, Table 4.5 lists the multiplexed I/O description.
Table 4.5 Multiplex I/O Description

<table>
<thead>
<tr>
<th>I/O addressing</th>
<th>Voltage</th>
<th>Level Output</th>
<th>PWM</th>
<th>Level Input</th>
<th>ADC</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>3.3V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>19</td>
<td>3.3V</td>
<td>-</td>
<td>-</td>
<td>√</td>
<td>-</td>
</tr>
<tr>
<td>20</td>
<td>3.3V</td>
<td>-</td>
<td>-</td>
<td>√</td>
<td>-</td>
</tr>
</tbody>
</table>

4.3.1.2 Multiplexed Peripheral Interface Description

Figure 4.4 shows the peripheral interface on the base, and Table 4.6 lists the multiplexed I/O description.

![Peripheral Interface Diagram](image-url)
Table 4.6  Multiplexed I/O Description

<table>
<thead>
<tr>
<th>I/O addressing</th>
<th>Voltage</th>
<th>Level Output</th>
<th>PWM</th>
<th>Level Input</th>
<th>ADC</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>5V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>11</td>
<td>3.3V</td>
<td>√</td>
<td>√</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>12</td>
<td>3.3V</td>
<td>-</td>
<td>-</td>
<td>√</td>
<td>-</td>
</tr>
<tr>
<td>13</td>
<td>5V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>14</td>
<td>3.3V</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>-</td>
</tr>
<tr>
<td>15</td>
<td>3.3V</td>
<td>√</td>
<td>-</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>16</td>
<td>12V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>17</td>
<td>12V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

4.3.2  Multiplexed Forearm I/O Interface Description

Figure 4.5 shows the peripheral interface on the Forearm. Table 4.7 lists the multiplexed I/O description.

Figure 4.5  Peripheral interface in the Forearm
### Table 4.7 Multiplexed I/O description

<table>
<thead>
<tr>
<th>I/O addressing</th>
<th>Voltage</th>
<th>Level Output</th>
<th>PWM</th>
<th>Level Input</th>
<th>ADC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.3V</td>
<td>√</td>
<td>-</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>2</td>
<td>12V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>12V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>3.3V</td>
<td>√</td>
<td>√</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>3.3V</td>
<td>-</td>
<td>-</td>
<td>√</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>3.3V</td>
<td>√</td>
<td>√</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>3.3V</td>
<td>-</td>
<td>-</td>
<td>√</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>3.3V</td>
<td>√</td>
<td>√</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>9</td>
<td>3.3V</td>
<td>√</td>
<td>-</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>
5. Operation

5.1 Introduction to the DobotStudio

5.1.1 Function Modules

You can use the DobotStudio to control the Dobot Magician to accomplish multiple functions such as **Teaching & Playback**, **Write & Draw**, **Blockly** graphic programming, and **Script** control, as shown in Figure 5.1. For details, see Table 5.1.

![Function Modules on the DobotStudio Page](image)

**Figure 5.1** The function modules on the DobotStudio page

<table>
<thead>
<tr>
<th>Function Modules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teaching &amp; Playback</td>
<td>Teach the Dobot Magician how to move and then record the movement to make Dobot Magician accomplish the recorded movements</td>
</tr>
<tr>
<td>Write &amp; Draw</td>
<td>Control the robotic arm to write, draw, or engrave an object using a laser</td>
</tr>
<tr>
<td>Blockly</td>
<td>Use Blockly to program the robotic arm in a graphic programming environment. It allows the users to drag and drop the blocks onto a workplace to generate execute code just as intuitive and easy as a block puzzle</td>
</tr>
<tr>
<td>Script</td>
<td>Control the robotic arm using the script commands</td>
</tr>
<tr>
<td>Leap Motion</td>
<td>Support hand motions as input to control the robotic arm via a Leap Motion controller</td>
</tr>
<tr>
<td>Mouse</td>
<td>Control the robotic arm using a mouse</td>
</tr>
<tr>
<td>LaserEngraving</td>
<td>Engrave a bitmap image on an object using a laser</td>
</tr>
<tr>
<td>3DPrinter</td>
<td>Capable of 3D printing</td>
</tr>
<tr>
<td>Add More</td>
<td>Add more custom functions to manipulate the robotic arm.</td>
</tr>
</tbody>
</table>
You can also set the Dobot Magician by clicking **Setting** on the DobotStudio page, for example, implement general settings, base calibration, manual levelling, and auto levelling, as shown in Figure 5.2. For details, see Table 5.2.

![General Setting page](image)

**Figure 5.2  The General Setting page**

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Set tutorial open or close, show console when startup, device name, use Linear rail V2</td>
</tr>
<tr>
<td>Firmware</td>
<td>Switch firmware</td>
</tr>
<tr>
<td></td>
<td>For example, you can switch to the 3D printer firmware to implement 3D printing from the currently selected Dobot firmware</td>
</tr>
<tr>
<td>Sensor and Base</td>
<td>Set the Base Encoder and the angle sensors on the Forearm and Rear Arm</td>
</tr>
<tr>
<td>Base Calibration</td>
<td>Calibrate the base Encoder</td>
</tr>
<tr>
<td>Manual Levelling</td>
<td>Manually calibrate the angle sensors on the Forearm and Rear Arm</td>
</tr>
<tr>
<td>Auto Levelling</td>
<td>Automatically calibrate the angle sensors on the Forearm and Rear Arm.</td>
</tr>
<tr>
<td>Initial Pos</td>
<td>Set the initial pose of the robotic arm.</td>
</tr>
<tr>
<td>Jog</td>
<td>Set the jogging speed and acceleration in the Joint coordinate system and Cartesian coordinate system</td>
</tr>
<tr>
<td>Playback</td>
<td>Set the joint parameters, coordinate parameters, Jump parameters, handhold teaching and LostStepParam.</td>
</tr>
<tr>
<td>Items</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Write Draw</td>
<td>Set the Write &amp; Draw function, such as speed, Junction velocity, linear</td>
</tr>
<tr>
<td></td>
<td>acceleration, acceleration, pen up offset and pen down position.</td>
</tr>
<tr>
<td>Leap Motion</td>
<td>Set the parameters such as speed, scale, and performance for hand gesture</td>
</tr>
<tr>
<td></td>
<td>control.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Set the parameters such as speed, scale, and performance for mouse control.</td>
</tr>
<tr>
<td>LaserEngraving</td>
<td>Set the parameters such as junction velocity, linear acceleration,</td>
</tr>
<tr>
<td></td>
<td>acceleration, pen down position, and DPI for laser engraving.</td>
</tr>
</tbody>
</table>

### 5.1.2 Common Areas of DobotStudio Page

The DobotStudio offers the following common areas shared by all the function modules to control the robotic arm.

- You can select the liner rail or an end-effector on the DobotStudio page, as shown in Figure 5.3.

![Figure 5.3 The linear rail and end-effector drop-down list](image)

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear rail</td>
<td>When the robotic arm is connected to a linear rail, click this item to enable</td>
</tr>
<tr>
<td>End-effector drop-down</td>
<td>When the end-effector is a suction cup kit, gripper kit, laser kit or writing</td>
</tr>
<tr>
<td>list</td>
<td>and drawing kit, select the corresponding kit in this list</td>
</tr>
</tbody>
</table>

- You can also perform other operations on the DobotStudio page such as Setting, Home, Emergency Stop, and viewing the versions, as shown in Figure 5.4.

![Figure 5.4 Setting, Home, Emergency Stop, and viewing the versions](image)

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
<td>Set the robotic arm such as firmware upgrade, sensor and base setup. For</td>
</tr>
<tr>
<td></td>
<td>details, please refer to Table 5.2</td>
</tr>
</tbody>
</table>

Table 5.3 The linear rail and end-effector drop-down list

Table 5.4 Setting, Home, Emergency Stop, and viewing the versions
### Home
Set the Dobot Magician back to its home position to get a correct reference position. When the Dobot Magician is moving, if its movement is hindered by an obstacle or the stepper motors lost steps, perform the homing operation.

### Emergency Stop
Stop the robotic arm if an emergency occurs.

### View the version information such as DobotStudio version, firmware version, and hardware version

### Switch system language

With the **Operation Panel** on the **DobotStudio** page, you can teach the robotic arm to perform a specific task such as jogging the robotic arm in the Cartesian or joint coordinate system, or controlling a gripper, suction cup, or laser, as shown in Figure 5.5. For details, please refer to Table 5.5.

![Operation Panel](image)

**Figure 5.5** Setting the Operation Panel

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinate jogging</td>
<td>Jog the Dobot Magician by clicking X (X+/−), Y (Y+/−), Z (Z+/−), or R (R+/−) in the Cartesian coordinate system</td>
</tr>
<tr>
<td>Items</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Joint jogging</td>
<td>Jog the Dobot Magician by clicking J1+/-, J2+/-, J3+/-, or J4+/- in the Joint coordinate system</td>
</tr>
<tr>
<td>Linear control</td>
<td>When the linear rail is enabled (see Table 5.3), click L+/- to move the robotic arm along the rail. Value range: 0 mm - 1000 mm</td>
</tr>
<tr>
<td>Gripper control</td>
<td>When the end-effector is chosen as a Gripper, you can set the gripper to open, close, or disable in the Gripper drop-down box</td>
</tr>
<tr>
<td>Suction cup control</td>
<td>When the end-effector is chosen as a Suction Cup, select SuctionCup to power on the air pump. If unselected, the air pump is powered off</td>
</tr>
<tr>
<td>Laser control</td>
<td>When the end-effector is chosen as a Laser, select Laser to turn on the laser. If unselected, the laser is turned off</td>
</tr>
<tr>
<td>Jogging speed control</td>
<td>Set the jogging speed percentage Default value: 50% Value range: 1% - 100%</td>
</tr>
</tbody>
</table>

5.2 Performing Teaching & Playback Tasks

This topic introduces how to perform a teaching & playback task to suck or grab a small cube. Because a suction cup kit or a gripper kit is required, we will explain them first.

5.2.1 Installing a Suction Cup Kit

A suction cup kit is the default end-effector shipped with the Dobot Magician. When using the suction cup kit, an air pump is necessary, as shown in Figure 5.6.

![Suction Cup Kit](image)

**Figure 5.6** A suction cup kit

**Procedure**

**Step 1** Connect the air pump’s power cable SW1 to the SW1 connector on the Dobot Magician base’ rear panel and the signal cable GP1 to the GP1 connector, as shown
in Figure 5.7.

![Figure 5.7 Connect the air pump to the Dobot Magician](image)

**Step 2** Insert a suction cup kit into the end’s port, and fasten it with clamp fixing screw, as shown in Figure 5.8.

![Figure 5.8 Install a suction cup kit](image)

**Step 3** Connect the air pump’s air tube to the air tube connector of the suction cup kit, as shown in Figure 5.9.
**Figure 5.9**  Install an air tube

**Step 4**  Connect the servo’s **GP3** cable to the **GP3** connector on the Forearm, as shown in Figure 5.10.
5.2.2 Installing a Gripper Kit

An air pump should be used with the gripper kit, as shown in Figure 5.11, to open or close the gripper.

Figure 5.10 Connect the servo’s GP3 cable to the GP3 connector

Figure 5.11 A gripper kit
Procedure

Step 1  Dismantle the suction cup by unfastening its terminal strand with a 1.5mm hexagon wrench, as shown in Figure 5.12.

![Dismantle the suction cup](image)

Figure 5.12  Dismantle the suction cup

Step 2  Install a gripper kit to the servo with a 2.5mm hexagon wrench, as shown in Figure 5.13.

![Install a gripper kit](image)

Figure 5.13  Install a gripper kit

Step 3  Connect the gripper kit and an air pump to the Dobot Magician in the same way as the suction cup kit is installed. For details, see 5.2.1 Installing a Suction Cup Kit. Figure 5.14 shows the effect of the gripper kit installation.
5.2.3 Teaching & Playback Page

The Teaching & Playback page is shown in Figure 5.15. To access it, select Connect > Teaching & Playback on the DobotStudio page.

- In both Easy and Pro modes, you can switch between Easy and Pro modes, set loop, speed percentage, and acceleration percentage, as shown in Figure 5.16.
Table 5.6  Set Easy/Pro, Loop, Speed and acceleration (Acc)

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Easy/Pro</td>
<td>Click this slider to switch between Easy and Pro modes. The default is the Easy mode. Apart from all the functions in the Easy mode, the Pro mode offers multiple features such as the offline mode and multiplexed I/O interface</td>
</tr>
<tr>
<td>Loop</td>
<td>Set the loop that the robotic arm plays back the recorded steps. Default value: 1. Value range: 1 - 999999</td>
</tr>
<tr>
<td>Speed</td>
<td>Set the speed ratio when doing playback. Default value: 50%. Value range: 0% - 100%</td>
</tr>
<tr>
<td>acceleration</td>
<td>Set the acceleration ratio when doing playback. Default value: 50%. Value range: 0% - 100%</td>
</tr>
<tr>
<td>(Acc)</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the current Teaching &amp; Playback page to return to the DobotStudio page</td>
</tr>
</tbody>
</table>

- In both Easy and Pro modes, you can save points, set the motion mode and the pause time for a save point, as shown in Figure 5.17.

Figure 5.17  Set the save points, motion modes and pause time

Table 5.7  Set the save points, motion modes, and pause time

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+Point</td>
<td>Click to create a new save point in the Save points list</td>
</tr>
<tr>
<td>Motion mode</td>
<td>Choose a PTP (point to point) Point mode or ARC Point mode. In the PTP Point mode, you can select MOVJ, MOVL, or JUMP mode while the ARC Point mode requires a second point cirPoint and a finish point toPoint as well as the start point set via the PTP Point mode</td>
</tr>
</tbody>
</table>
In both Easy and Pro modes, you can edit a highlighted save point such as copy, paste, cut, switch between motion modes, modify name and coordinates, as shown in Figure 5.18.

![Figure 5.18 The Save points list](image)

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause time</td>
<td>Set the pause time for a save point</td>
</tr>
</tbody>
</table>

![Table 5.8 The Save points list](image)

- **Pro mode**: To enter the Pro mode from the current Easy mode, click the Easy/Pro slider, as shown in Figure 5.19. Apart from all the functions in the default Easy mode, the Pro mode allows the robotic arm to run a save point each time, detect lost-steps, work in offline mode, and perform the multiplexed I/O interface. For details, see Table 5.9.
Figure 5.19 The Pro mode of the Teaching & Playback function

Table 5.9 The Pro mode of the Teaching & Playback function

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>StepRun</strong>: run a save point each time in the Save points list. Before clicking <strong>StepRun</strong>, please select a saved point.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Download</strong>: download the Save points list to the Dobot Magician for working in offline mode. For details, see 5.3 <strong>Working in Offline Mode</strong></td>
</tr>
</tbody>
</table>
| 3   | **Check Lost Step**: the Dobot Magician detects if lost-steps occur in its movements. The default threshold is 5 degrees. It should be at least 0.5 degrees. You can set the threshold by selecting **Setting > Playback > LostStepParam**.  
If **Check Lost Step** is selected, the robotic arm detects if the stepper motors lose steps when moving. If unselected, no detection is performed  
If the Dobot Magician detects lost-steps, it stops working, and its LED indicator turns red. In this case, click **Home** to get a correct reference position |
| 4   | **Multiplexed I/O interface**: control the Dobot Magician via the I/O interfaces such as turning on or off the air pump |

5.2.4 **ARC Motion Mode**

**Application Scenarios**

The **ARC** motion mode requires three points in an arc to complete the arc movement process. In the **ARC** motion mode, only the second point and end point are saved while the start point is determined by the other modes.

**Prerequisites**

The Dobot Magician has been powered on and connected to your computer.
**Procedure**

⚠️ **NOTICE**

Note the following rules when saving points to prevent the robotic arm from working outside its normal workspace.

- Any two points cannot coincide.
- The three points cannot be in the same straight line.
- The arc trajectory cannot exceed the Dobot Magician’s normal workspace.

For example, the points A, B, and C are on the arc. Point A is the start point; Point B is the second point; Point C is the end point, as shown in Figure 5.20.

![Figure 5.20 The arc trajectory](image)

**Step 1** Click **Teaching & Playback**

The **Teaching & Playback** page is displayed.

**Step 2** Save the start point A.

1. Select **MOVJ** motion mode in the Save Point area.

2. Click to display the **Operation Panel**, as shown in Figure 5.21.

![Figure 5.21 Display the Operation Panel](image)
3. Set the jogging speed percentage to 50 on the Operation Panel.
4. Jog the Dobot Magician in the Cartesian or Joint coordinate system to move the robotic arm to a location called position A.
5. Click +Point to save the coordinate corresponding to the position A, as shown in Figure 5.22.

Figure 5.22  Save the start position A

Step 3  Save the second point B and the end point C.
1. Select cirPoint to save the second point in the Save Point area.
2. Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move the robotic arm to the second position B as required.
3. Click +Point to save the coordinate corresponding to the position B. In this case, the DobotStudio automatically changes the motion mode to toPoint to get ready to save the end position.
4. Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move the robotic arm to the end position C as needed.
5. Click +Point to save the coordinates corresponding to the positions B and C, as shown in Figure 5.23.
Step 4  Set the percentage of both speed and acceleration for playback, for example 50.

Step 5  Set Loop to 2.

Step 6  Click Start. The Dobot Magician performs the sequence of ARC trajectory as taught from its memory system, moving from positions A through C, as shown in Figure 5.24.

5.2.5  Teaching & Playback Example

Application Scenarios

You can use Teaching & Playback function module to manipulate the Dobot Magician to accomplish different tasks such as transportation or intelligent sort. This topic introduces how to move small cubes from position A to B in the JUMP motion mode.

Prerequisites

- The Dobot Magician has been powered on and connected to your computer.
• A suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit.

**Procedure**

**Step 1** Choose *SuctionCup* as the end-effector on the *DobotStudio* page, as shown in Figure 5.25.

![Figure 5.25 Choose SuctionCup as the end-effector](image)

**Step 2** Click *Teaching & Playback*.

The *Teaching & Playback* page is displayed.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>After reading the beginner guide of the DobotStudio, click to close it.</td>
</tr>
</tbody>
</table>

**Step 3** Save the start point A.

1. Put a small cube on the work surface near the suction cup kit.
2. Select the *MOVJ* motion mode in the Save Point area.
3. Click to display the *Operation Panel*, as shown in Figure 5.26.
4. Set the jogging speed percentage to 50 on the Operation Panel.

**NOTE**

To change the jogging speed, select Setting > Jog to set the speed and acceleration of the joints, linear rail, or the Cartesian coordinate system, as shown in Figure 5.27.

![Figure 5.26 Display the Operation Panel](image1)

![Figure 5.27 Adjust the jogging speed](image2)
NOTICE

Regarding the jogging speed and acceleration in the Joint coordinate system and Cartesian coordinate system, we recommend that it should be less than 500mm/s if loaded and that less than 800mm/s if not loaded.

5. Jog the Dobot Magician in the Cartesian or Joint coordinate system to move the suction cup close enough to the small cube for picking-up. For example, the suction cup reaches this location called position A.

6. Select SuctionCup on the Operation Panel to turn on the air pump to pick up the small cube.

7. Set the PauseTime to 1 second in the Save Point area.

8. Click +Point to save the coordinate corresponding to the position A, as shown in Figure 5.28.

![Figure 5.28 Save the start position A](image)

**Step 4** Save the end point B.

1. Select the JUMP motion mode in the Save Point area.

**NOTE**

To change the jogging speed percentage, drag the speed slider.

2. Set the lifting height (JumpHeight) and the maximum lifting height (Z Limit) by selecting Setting > Playback > JumpParam, as shown in Figure 5.29.
3. Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move the small cube to the end position B as required.

4. Unselect **Sucktion Cup** to turn off the air pump to release the small cube.

5. Click **+Point** to save the coordinate corresponding to the position B, as shown in Figure 5.30.

![Figure 5.30 Save the end position B](image)

**Step 5**  Set the percentage of both speed and acceleration for playback, for example, 50.

**NOTE**

To change the speed and acceleration of playback, select **Setting > Playback** >
JointParam/CoordinateParm to adjust the speed and acceleration of the Cartesian or Joint coordinate system, as shown in Figure 5.31. For details, see Table 5.10.

![Figure 5.31](image)

Set the speed and acceleration of the playback

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JointParam</td>
<td>Set the speed and acceleration of the joints</td>
</tr>
<tr>
<td>CoordinateParam</td>
<td>Set the speed and acceleration in the Cartesian coordinate system</td>
</tr>
<tr>
<td>JumpParam</td>
<td>Set the Jump height and Z limit, which are required in the JUMP motion mode</td>
</tr>
<tr>
<td>Handhold Teaching</td>
<td>Enable or disable the handhold teaching.</td>
</tr>
<tr>
<td></td>
<td>Automatically save a point when releasing the unlock button or pressing this button</td>
</tr>
<tr>
<td>LostStepParam</td>
<td>Set the lost-step checking threshold</td>
</tr>
</tbody>
</table>

⚠️ NOTICE

We recommend that the motion range of Joint 1 should be 60° to -90°, the motion range of Joint 2 should be 0° to 85°, the motion range of Joint 3 is -5° to 85°, and the motion range of Joint 4 is -90° to 90°.

**Step 6** Set Loop to 2.

**Step 7** Place the small object back to the position A, and click Start The Dobot Magician.
performs the sequence of JUMP trajectory as taught from its memory system, moving the small cube from positions A through B.

![Figure 5.32 Move the small cube in the JUMP motion mode](image)

5.3 Working in Offline Mode

Offline mode allows the Dobot Magician to perform the points in the Save points list previously downloaded from the DobotStudio without keeping the USB connection established.

**Prerequisites**

- The Dobot Magician has been powered on.
- The Dobot Magician has been connected to the DobotStudio.
- The points have been saved.

**Procedure**

**Step 1**  Click the Easy/Pro slider to enter the Pro mode on the Teaching & Playback page.

**Step 2**  Click Download.

The Question dialog box is displayed, asking if you want the Dobot Magician to automatically go back to its homing point before performing the save points in the offline mode, as shown in Figure 5.33.
Step 3  Click OK to download the Save points list.
When the process bar at the bottom of the DobotStudio page shows 100% and then disappears, it means that the download is complete, as shown in Figure 5.34.

Step 4  Disconnect the DobotStudio from the Dobot Magician or the USB cable between the robotic arm and your computer.
Step 5  Short press the Key button once on the base’s rear panel.
Step 6  The Dobot Magician returns to its homing point and performs the downloaded save points. To stop the robotic arm’s movement, short press the Key button once.
**NOTICE**

- Before using offline mode, Dobot Magician needs to be reset by clicking **Home** to make Dobot Magician more accurate. For the details please refer to Appendix A Dobot Magician Homing Operation
- If press down **Key** button for long time, Dobot Magician will execute homing operation directly.

### 5.4 Writing and Drawing

Figure 5.35 shows the process of writing and drawing.

![Flowchart of Writing and Drawing Process](image)

**Figure 5.35** The process of writing and draw

#### 5.4.1 Installing a Writing and drawing kit

A writing and drawing kit consists of a pen and a pen holder. For detailed steps, see below.

**Step 1** Install a pen in the pen holder.

**Step 2** Fasten the writing and drawing kit to the Dobot Magician’s end with clamp fixing screw, as shown in Figure 5.36,
Figure 5.36  Install a writing and drawing kit

**NOTE**

To change to a new pen, unfasten the four M3*5 set screws in the pen holder with a 1.5mm hexagon wrench, as shown in Figure 5.37.

Figure 5.37  Change to a new pen

**Step 3**  Position a sheet of paper on the work surface within the workspace of the Dobot Magician.

### 5.4.2  Connecting the DobotStudio

**Step 1**  Launch the DobotStudio, and select the COM port, and then click **Connect**.

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of the Dobot firmware, the **Select tool** dialog box is displayed, asking if you want to switch to the Dobot firmware. In this case, perform the following steps to switch to this firmware.

1. Select **DobotStudio** to upgrade the Dobot firmware, as shown in Figure 5.38.
The dialog box is displayed.

![Figure 5.38 Select the DobotStudio to upgrade the Dobot firmware](image)

Figure 5.38 Select the DobotStudio to upgrade the Dobot firmware

2. Click **OK**, as shown in Figure 5.39.

The Dobot firmware upgrade window is displayed.

![Figure 5.39 Confirm the firmware upgrade](image)

Figure 5.39 Confirm the firmware upgrade

3. Click **Confirm** to upgrade the Dobot firmware, as shown in Figure 5.40. When the upgrade process bar shows 100%, and a short beep sound is heard, it means that the firmware is upgraded successfully, as shown in Figure 5.41. In this case, the LED indicator turns from red to green. Then click **Quit** to exit.

![Figure 5.40 Click Confirm](image)
WARNING

During the firmware upgrade, do not stop it. Otherwise, errors occur.

**Step 2**  Click **Connect** on the **DobotStudio** page to connect the **DobotStudio** to the Dobot Magician.

**Step 3**  Click **Write & Draw**, as shown in Figure 5.42.

![Figure 5.42 Click Write & Draw](image)

**Step 4**  Choose **Pen** as the end-effector on the **Write & Draw** page, as shown in Figure 5.43.
5.4.3 Importing Image Files and Setting Writing Parameters

When performing a write & draw task, a built-in or custom image file is required. Only a PLT or SVG image can be used. The built-in file is located in the directory `Installation Directory \DobotStudio\config\prefab\system\source`.

Prerequisites

A PLT or SVG image file has been created.

Procedure

1. **Step 1** Click **Write & Draw** on the **DobotStudio** page, as shown in Figure 5.44.

2. **Step 2** Import an image file using one of the following methods.

⚠️ **NOTICE**
The imported image should be placed within the annular area on the **Write & Draw** page, as shown in Figure 5.45. If not, the robotic arm reaches its limited position and cannot draw or write. In this case, the image is highlighted with a red border, as shown in Figure 5.46.

![Figure 5.45 The PLT or SVG image is located within the annular area](image1)

![Figure 5.46 The PLT or SVG image is located outside the annular area](image2)

- Click **Open** on the **Write & Draw** page to import a built-in PLT or SVG image file from the DobotStudio installation directory `InstallatonDirectory\DobotStudio\config\prefab\system\source`, as shown in Figure 5.47. You can also import your custom PLT or SVG image file.
Figure 5.47  Open a PLT or SVG system image file
- Click a shape in the Input Shapes area, as shown in Figure 5.48.

![Figure 5.48 Insert a system image file](image)

- Click Input Texts on the Write & Draw page to input texts, and set its style, and then click OK to display the text on the annular area, as shown in Figure 5.49.

![Figure 5.49 Input text](image)

- Click Open to import an image file such as BMP, JPEG, or PNG to convert this image to its corresponding SVG file that the DobotStudio supports, as shown in Figure 5.50. Once this image is imported, the SVG Converter dialog box is displayed, as shown in Figure 5.51. In this dialog box, drag the slider to set the black and white threshold, and click Convert Bitmap To SVG to perform the conversion, and then click Plot to Main Scene to display the converted SVG file on the annular area of the Write & Draw page.


**Figure 5.50 Import an image**

**Figure 5.51 Convert an image to SVG**

⚠️ **NOTICE**

After image is converted to SVG, if there are single colors and fewer lines in image, you need to adjust threshold, otherwise picture can’t be uploaded to DobotStudio.

**Figure 5.52 Error tip**

**Step 3**  Set the writing parameters.
1. Click **Setting** on the **Write & Draw** page, as shown in Figure 5.53.

2. Click **Write & Draw** to set the Dobot Magician’s **Velocity** (mm/s), junction velocity (**JunctionVel**: mm/s), **PlanAcc** (mm/s²), acceleration (**Acc**: mm/s²), **PenUpOffset** (mm), **PenDown** (mm), as shown in Figure 5.54.

**NOTE**

We recommend to set the Velocity in the range of 0mm/s to 500mm/s and to adjust the acceleration between 0mm/s² and 500mm/s².
5.4.4 Adjust the Position of the Pen Nib

Procedure

Step 1 Raise and lower the position of the pen nib.

Press and hold the unlock button on the Forearm to move the Dobot Magician to raise and lower the pen nib until it slightly squeezes the paper. You can also jog the robotic arm in the Cartesian or Joint coordinate system to slowly pull the Z axis down to a suitable vertical position for writing, as shown in Figure 5.55.

![Adjust the position of the pen nib](image)

**Figure 5.55** Adjust the position of the pen nib

**NOTE**

The point marked by a red box, as shown in Figure 5.56, corresponds to the position of the writing and drawing kit of the Dobot Magician. This point changes its position only within the annular area when the robotic arm moves.

![The point corresponding to the laser kit of the robotic arm](image)

**Figure 5.56** The point corresponding to the laser kit of the robotic arm
Step 2  Click **AutoZ** on the **Write & Draw** page to obtain and save the current value of the Z axis.

Once this step is complete, the next time you start to write, directly import a PLT or SVG image file without adjusting the position of the pen nib, and click **SyncPos**, and then click **Start** to start writing on the paper, as shown in Figure 5.57.

![Figure 5.57  Lock the height of writing](image)

**NOTE**

The value of the Z axis is the **PenDown** parameter. This parameter can be set by selecting **Setting > Write Draw > PenDown** on the **Write & Draw** page, as shown in Figure 5.58. If the effect of writing is not satisfactory, slightly raise and lower the height of the writing and drawing kit or directly change the value of **PenDown**.
Figure 5.58 The PenDown parameter

Step 3 Click SyncPos.
The Dobot Magician automatically moves above the position (PenDown) of the start point of the text.

Step 4 Click Start to start writing on the paper.
When writing, click Pause to pause the writing and Stop to halt the writing.

5.5 Performing Laser Engraving Tasks

Figure 5.59 shows the process of laser engraving.

⚠️ NOTICE

The LaserEngraving is different from the grayscale engraving. The former uses the same firmware and DobotStudio function module as those of the Write & Draw function, and it can only engrave a vector graphics by drawing lines while the latter can engrave a grayscale image. For more information about the grayscale engraving, see 5.6 Engraving a Grayscale Image.

5.5.1 Installing a Laser Kit

Procedure
A laser kit includes a laser. For detailed steps, see below.

**Step 1**  Fasten the laser kit to the Dobot Magician's end with clamp fixing screw, as shown in Figure 5.60.

![Clamp fixing screw](image)

**Figure 5.60**  Fasten the laser with clamp fixing screw

**Step 2**  Connect the laser’s power cable to the SW4 connector on the Forearm and the TTL control cable to the GP5 connector, as shown in Figure 5.61.
5.5.2 Connecting the DobotStudio

**Step 1** Launch the DobotStudio, and select the COM port, and then click **Connect**.

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of the Dobot firmware, the **Select tool** dialog box is displayed, asking if you want to switch to the Dobot firmware. In this case, perform the following steps to switch to this firmware.

1. Select **DobotStudio** to upgrade the Dobot firmware, as shown in Figure 5.62. The **Question** dialog box is displayed.

![Select tool dialog box](image)

**Figure 5.62** Select the DobotStudio to upgrade the Dobot firmware
2. Click **OK**, as shown in Figure 5.63.
   
The Dobot firmware upgrade window is displayed.

   ![](image1.png)

   **Figure 5.63** Confirm the firmware upgrade

3. Click **Confirm** to upgrade the Dobot firmware, as shown in Figure 5.64. When the upgrade process bar shows 100% and a short beep sound is heard, it means that the firmware is upgraded successfully, as shown in Figure 5.65. In this case, the LED indicator turns from red to green. Then click **Complete** to exit.

   ![](image2.png)

   **Figure 5.64** Click **Confirm**
WARNING

During the firmware upgrade, do not stop it. Otherwise, errors occur.

Step 2  Click Connect on the DobotStudio page to connect the DobotStudio to the Dobot Magician.

Step 3  Click Write & Draw module function, as shown in Figure 5.66.

Step 4  Choose Laser as the end-effector, as shown in Figure 5.67.
5.5.3 Importing Image Files and Setting Engraving Parameters

When performing a laser-engraving task, a built-in or a custom image file is required. Only a PLT or SVG image can be used. The built-in image file is located in the directory:

Installation Directory\DobotStudio\config\prefab\system\source.

Prerequisites

A PLT or SVG image file has been created.

Procedure

Step 1  Click Write & Draw on the DobotStudio page, as shown in Figure 5.68.

Step 2  Import an image file using one of the following methods.

⚠️ NOTICE

The imported image should be placed within the annular area on the Write & Draw page, as shown in Figure 5.69. If not, the robotic arm reaches its limited position and thus
cannot engrave on an object. In this case, the image is highlighted with a red border, as shown in Figure 5.70.

![Figure 5.69 The PLT or SVG image is located within the annular area](image1)

![Figure 5.70 The PLT or SVG image is located outside the annular area](image2)

- Click **Open** on the **Write & Draw** page to import a built-in PLT or SVG image file from the DobotStudio installation directory `InstallationDirectory\DobotStudio\config\prefab\system\source`, as shown in Figure 5.71. You can also import your custom PLT or SVG image file.
- Click a shape in the **Input Shapes** area to directly import a system image file, as shown in Figure 5.72.

- Click **Input Texts** on the **Write & Draw** page to input texts, and set its style, and then click **OK** to display the text on the annular area, as shown in Figure 5.73.
Click **Open** to import an image file such as BMP, JPEG, or PNG to convert this image to its corresponding SVG file that the DobotStudio supports, as shown in Figure 5.74. Once this image is imported, the **SVG Converter** dialog box is displayed, as shown in Figure 5.75. In this dialog box, drag the slider to set the black and white threshold, and click **Convert Bitmap To SVG** to perform the conversion, and then click **Plot to Main Scene** to display the converted SVG file on the annular area of the **Write & Draw** page.
Figure 5.75  Convert Bitmap to SVG

Step 3  Set the laser-engraving’s parameters.

1. Click Setting on the Write & Draw page, as shown in Figure 5.76.

![Figure 5.76 Click Setting]

2. Click Write & Draw to set the Dobot Magician’s Velocity (mm/s), junction velocity (JunctionVel: mm/s), PlanAcc (mm/s²), acceleration (Acc: mm/s²), PenUpOffset (mm), PenDown (mm), as shown in Figure 5.77.

⚠️ NOTE

We recommend to set the Velocity in the range of 0mm/s to 500mm/s and to adjust the acceleration between 0mm/s² and 500mm/s².
5.5.4 Adjust the Laser Focus and Start to Grave

Procedure

**Step 1** Choose Laser as the end-effector on the **Write & Draw** page, as shown in Figure 5.78.

**Step 2** Click to display the **Operation Panel**, and then select Laser to turn on the laser, as shown in Figure 5.79. In this case, the laser gives out a laser beam.
Danger

- When using a laser, wear lasing protective eyeglass.
- Never aim the laser at a person’s eye and clothes or stare at the laser from within the beam.
- In the central laser focus, a high temperature heat is created and can burn materials such as papers and wooden boards.
- Never aim the laser at a person and their clothes.
- Do not allow the children to play with the Dobot Magician. Monitor the robotic arm while it is running and power off it once the movement is complete.

Step 3  Press and hold the unlock button on the Forearm to move the robotic arm to raise and lower the height of the laser kit until the laser is the brightest with a smallest possible spot size. When the laser power level is high enough, the laser beam can burn and cut the paper. After getting a pretty good focus, unselect Laser on the Operation Panel page to turn off the laser, as shown in Figure 5.80.

![Figure 5.80 Unselect the Laser](image)

Notice

- If you cannot set the laser to be at its minimum focus, it’s probably because the focal length is long. To shorten the focal length, slightly turn the sliver lens screw (as shown in Figure 5.81) on the bottom of the laser kit.
The point marked by a red box, as shown in Figure 5.82, corresponds to the position of the end-effector of the Dobot Magician. This point changes its position only within the annular area when the robotic arm moves.

Step 4  Click **AutoZ** on the **Write & Draw** page to obtain and save the current value of Z axis.

Once this step is complete, the next time you start to engrave, directly import a PLT or SVG image file without adjusting the position of the laser kit, and click **SyncPos**, and then click **Start** to start engraving on the paper, as shown in Figure 5.83.
NOTE

The value of the Z axis is the PenDown parameter. This parameter can be set by selecting Setting > Write Draw > PenDown on the Write & Draw page, as shown in Figure 5.84. If the effect of engraving is not satisfactory, slightly raise and lower the height of the laser kit or directly change the value of PenDown.
Step 5  Click SyncPos.
The Dobot Magician automatically moves above the position (PenUpOffset) of the start point of the laser-engraving.

Step 6  Click Start to start engraving on the paper.
When engraving, click Pause to pause the engraving and Stop to halt the engraving.
Figure 5.85 shows the effect of the laser-engraving.

![Image of laser-engraving effect]

Figure 5.85  The effect of the laser-engraving

5.6  Engraving a Grayscale Image

Figure 5.86  shows the process of engraving a grayscale image.
5.6.1 Installing a Grayscale-engraving Kit

Both grayscale-engraving and laser-engraving use the laser kit as the end-effector. For the installation method, see 5.5.1 Installing a Laser Kit.

5.6.2 Connecting the DobotStudio

**Step 1** Launch the DobotStudio, and select the COM port, and then click **Connect**.

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of the Dobot firmware, the **Select tool** dialog box is displayed, asking if you want to switch to the Dobot firmware. In this case, perform the following steps to switch to this firmware.

1. Select **DobotStudio** to upgrade the Dobot firmware, as shown in Figure 5.87. The **Question** dialog box is displayed.
2. Click **OK**, as shown in Figure 5.88.

The Dobot firmware upgrade window is displayed.

![Select tool](image)

**Figure 5.87** Select the DobotStudio to upgrade the Dobot firmware

![Confirm](image)

**Figure 5.88** Confirm the firmware upgrade

3. Click **Confirm** to upgrade the Dobot firmware, as shown in Figure 5.89. When the upgrade process bar shows 100%, and a short beep sound is heard, it means that the firmware is upgraded successfully, as shown in Figure 5.90. In this case, the LED indicator turns from red to green. Then click **Complete** to exit.

![Dobot firmware upgrade](image)

**Figure 5.89** Click Confirm

![Upgrade successful](image)
Figure 5.90  The firmware upgrade is successful

⚠️ **WARNING**

During the firmware upgrade, do not stop it. Otherwise, errors occur.
Step 2 Click LaserEngraving as shown in Figure 5.91.

![LaserEngraving interface](image)

**Figure 5.91 Click LaserEngraving**

### 5.6.3 Importing Image Files and Setting Engraving Parameters

**Prerequisites**

An image file has been created. You can also import system image, the importing path is `Installation Directory\DobotStudio\attachment\grbrMode\source`.

**Procedure**

⚠️ **NOTICE**

The imported image should be placed within the annular area on the LaserEngraving page, as shown in Figure 5.92. If not, the robotic arm reaches its limited position and thus cannot engrave on an object. In this case, the image is highlighted with a red border, as shown in Figure 5.93.
Step 1  Choose Laser as the end-effector on the Laser Engraving page, as shown in Figure 5.94.
Step 2  Click Open to import an image file such as BMP, JPEG, or PNG, as shown in Figure 5.95.

![Image of Importing an Image File]

**Figure 5.95  Import an image file**

Step 3  Set the Grayscale range, Laser power range, and Border, as shown in Figure 5.97. For details, see Table 5.11.

![Image of Setting Grayscale, Laser Power, and Border]

**Figure 5.97  Set the grayscale range, laser power range, and border**
### Table 5.11 Laser engraving parameters

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grayscale range</td>
<td>Set the grayscale range</td>
</tr>
<tr>
<td></td>
<td>Range: 0 - 255</td>
</tr>
<tr>
<td></td>
<td>Default value: 20 - 240</td>
</tr>
<tr>
<td>Laser power range</td>
<td>Set the laser power range</td>
</tr>
<tr>
<td></td>
<td>Range: 2 - 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 20 - 90</td>
</tr>
<tr>
<td>Border</td>
<td>Set the border width.</td>
</tr>
<tr>
<td></td>
<td>Unit: pixel</td>
</tr>
<tr>
<td></td>
<td>Range: 0 - 50</td>
</tr>
<tr>
<td></td>
<td>Default value: 4</td>
</tr>
</tbody>
</table>

**Step 4** Set the laser-engraving parameters.

1. Click **Setting** on the **LaserEngraving** page.
2. Set the **JunctionVel** (juncture velocity), **PlanAcc** (linear acceleration), and **Acc** (acceleration), for example, set all to 5, as shown in Figure 5.98.

![Figure 5.98 Set the parameters of laser engraving](image)

#### 5.6.4 Adjust the Laser Focus and Start to Engrave
Step 1  Click to display the Operation Panel, and then select Laser to turn on the laser, as shown in Figure 5.99. In this case, the laser gives out a laser beam.

⚠️ Danger

- When using a laser, wear lasing protective eyeglass.
- Never aim the laser at a person’s eye and clothes or stare at the laser from within the beam.
- In the central laser focus, a high-temperature heat is created and can burn materials such as papers and wooden boards.
- Never aim the laser at a person and their clothes.
- Do not allow the children to play with the Dobot Magician. Monitor the robotic arm while it is running and power off it once the movement is complete.

![Figure 5.99 Select the Laser](image)

Step 2  Adjust the laser focus.

Press and hold the unlock button on the Forearm to move the robotic arm to raise and lower the height of the laser kit until the laser is the brightest with a smallest possible spot size. When the laser power level is high enough, the laser beam can burn and cut the paper. After getting a pretty good focus, unselect Laser on the Operation Panel page to turn off the laser, as shown in Figure 5.100.
NOTICE

- If you cannot set the laser to be at its minimum focus, it’s probably because the focal length is long. To shorten the focal length, slightly turn the sliver lens screw (as shown in Figure 5.101) on the bottom of the laser kit.

![Figure 5.101 Adjust the focus](image)

- The point marked by a red box, as shown in Figure 5.102, corresponds to the position of the laser kit of the Dobot Magician. This point changes its position only within the annular area when the robotic arm moves.
Figure 5.102  The point corresponding to the laser kit of the robotic arm

**Step 3**  
Click **AutoZ** on the **LaserEngraving** page to obtain and save the current value of the Z axis.

Once this step is complete, the next time you start to engrave, directly import an image file without adjusting the position of the laser kit, and click **SyncPos**, and then click **Start** to start engraving on the paper, as shown in Figure 5.103.

Figure 5.103  Lock the height of engraving

**NOTE**

The value of Z axis is the **PenDown** parameter. This parameter can be set by selecting **Setting > LaserEngraving > PenDown**, as shown in Figure 5.104. If the effect of engraving is not satisfactory, slightly raise and lower the height of the laser kit or directly change the value of **PenDown**.
Set the PenDown parameters

**Step 4** Click **SyncPos**.
The Dobot Magician automatically moves above the position of the start point of the laser-engraving.

**Step 5** Click **Start** to start engraving on the paper.
When engraving, click **Pause** to pause the engraving and **Stop** to halt the engraving.

Figure 5.105 shows the effect of the laser-engraving.

---

**5.7 Controlling with your Hand Gesture**
You can use the **LeapMotion** function module of the DobotStudio to perform tasks, for example, grab or suck an object with your hand gesture.

### 5.7.1 Installing a Leap Motion Controller

**Prerequisites**

- The Leap Motion controller (a hand gesture controller) has been obtained.
- The Leap Motion driver software has been obtained. Download the Windows version, as shown in Figure 5.106, from the [https://www.leapmotion.com/setup/desktop/windows](https://www.leapmotion.com/setup/desktop/windows).

![Download the Leap Motion driver software for Windows](DOWNLOAD FOR WINDOWS)

Dive in to the future of VR with our Orion beta software.

**DEVELOPER SDK**

Or download our V2 software for Windows, Mac, or Linux.

Minimum system requirements

---

**Figure 5.106** Download the Leap Motion driver software for Windows

**Procedure**

**Step 1** Connect a Leap Motion controller to your computer with a USB cable, and put it on the work surface with its face up, as shown in Figure 5.107.

![Connect the Leap Motion controller to your computer](Figure 5.107)

**Step 2** Install the Leap Motion driver software by following the on-screen instructions, as shown in Figure 5.108.
5.7.2 Leap Motion Demo

You can move or sort an object with the LeapMotion function. This topic introduces how to move a small cube with a hand gesture.

Prerequisites

- The Dobot Magician is powered on and connected to your computer.
- The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit.

Procedure

Step 1 Launch the DobotStudio, and click Connect to connect to the Dobot Magician.

Step 2 Click LeapMotion, as shown in Figure 5.109.

![Leap Motion Demo Interface](image-url)
Step 3  Click **Setting** on the **DobotStudio** page, as shown in Figure 5.110.

![Figure 5.110  Click Setting](image)

Step 4  Click **Leap Motion**, as shown in Figure 5.111. Set the parameters, as shown in Table 5.12, and click **OK**.

![Figure 5.111  Set the parameters of the Leap Motion function](image)

<table>
<thead>
<tr>
<th>Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Speed
- The velocity percentage of the Dobot Magician:
  - Unit: %
  - Value range: 1 - 100
  - Default value: 50

### Scale
- The scale of the Dobot Magician:
  - Unit: %
  - Value range: 1 - 100
  - Default value: 100

### High performance/Low performance
- Choose a performance mode suitable for your computer. Select the Low performance (default) for the low configuration computer to prevent video delay.

---

**Step 5** Choose **SuctionCup** as the end-effector on the **DobotStudio** page, and click **Start** to control the **Dobot Magician** with your hand gesture, as shown in Figure 5.112. To maintain the Dobot Magician in a stable state, move your hand into the workspace of the Leap Motion controller while keeping your palm upward. And turn your palm down, and then move your hand above this area to control the Dobot Magician.

![Image of Dobot Magician control interface]

**Figure 5.112** Click Start

**NOTE**
Move your hand in the workspace of the Leap Motion controller to control the Dobot Magician to perform a particular task, as shown in Table 5.13.

<p>| Table 5.13 | The robotic arm’s movement created with your hand gesture |</p>
<table>
<thead>
<tr>
<th>Hand gesture</th>
<th>Robotic arm’s movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move your palm up, down, front, back, right, or left</td>
<td>The robotic arm moves accordingly</td>
</tr>
<tr>
<td>Clench your fist</td>
<td>Control the air pump to suck air</td>
</tr>
<tr>
<td>Unclench your fist</td>
<td>Turn off the air pump</td>
</tr>
</tbody>
</table>

**Step 6**  
Put a small cube on the work surface in the workspace of the Dobot Magician, such as point A, and use the hand gesture to move robotic arm above the cube until it’s close to the cube.

**Step 7**  
Clench your fist to control the air pump to suck the small cube, and move your fist to make Dobot Magician take the cube to another position while clenching your fist, such as position B, and then unclench your fist to turn off the air pump to drop the cube.

**Step 8**  
Turn your palm upward and click **Stop** to stop the hand control.

## 5.8 Controlling with your Mouse

You can use the **Mouse** function module of the DobotStudio to perform tasks, for example, grab or suck an object with your mouse. This topic introduces how to move a small cube with a mouse.

**Prerequisites**

- The Dobot Magician is powered on and connected to your computer.
- The suction cup kit has been installed. For details, see 5.2.1 *Installing a Suction Cup Kit*.

**Procedure**

**Step 1**  
Click **Mouse**, as shown in Figure 5.113,

![Figure 5.113 Click Mouse](image)

**Step 2**  
Choose **SuctionCup** as the end-effector on the **DobotStudio** page, as shown in
Figure 5.114, Choose SuctionCup as the end-effector

Step 3  Click **Setting** as shown in Figure 5.115.

Click **Mouse**, as shown in Figure 5.116. Set the parameters, as shown in of mouse control Table 5.14, and click **OK**.
Figure 5.116 Set the parameters of mouse control

Table 5.14 Set the parameters of mouse control

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>The velocity percentage of the Dobot Magician:</td>
</tr>
<tr>
<td></td>
<td>Unit: %</td>
</tr>
<tr>
<td></td>
<td>Value range: 1 - 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 50</td>
</tr>
<tr>
<td>Scale</td>
<td>The scale of the Dobot Magician:</td>
</tr>
<tr>
<td></td>
<td>Unit: %</td>
</tr>
<tr>
<td></td>
<td>Value range: 1 - 100</td>
</tr>
<tr>
<td></td>
<td>Default value: 100</td>
</tr>
<tr>
<td>High performance/Low</td>
<td>Choose a performance mode suitable for your computer. Select <strong>Low</strong></td>
</tr>
<tr>
<td>performance</td>
<td><strong>performance</strong> (default) for the low configuration computer to prevent video delay</td>
</tr>
</tbody>
</table>

**Step 1** Put a small cube on the work surface in the workspace of the Dobot Magician, such as point A.

**Step 2** Press V to enable the mouse control of the Dobot Magician. Press and hold the left mouse button to drag the mouse within the red annular area to move the robotic arm, as shown in Figure 5.117.

⚠️ NOTICE

Do not move the mouse outside the red annular area. If not, the robotic arm reaches its
limited position. In this case, drag the mouse to into the annular area.

![Image of robotic arm control interface]

**Figure 5.117**  Move the robotic arm in the red annular area

**Step 3**  Move the Dobot Magician above the cube by dragging the mouse and then place it close to the cube.

![Image of robotic arm control interface]

For details on how to use the mouse to control the robotic arm on the Mouse page, see Table 5.15.

**Table 5.15**  The robotic arm’s movement created with your mouse

<table>
<thead>
<tr>
<th>Mouse action</th>
<th>Robotic arm’s movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move your mouse front, back, right, or left</td>
<td>The robotic arm moves accordingly</td>
</tr>
<tr>
<td>Scroll the mouse wheel up or down</td>
<td>The robotic arm moves accordingly</td>
</tr>
<tr>
<td>Press and hold the left mouse button</td>
<td>Suction cup: the air pump sucks air in</td>
</tr>
<tr>
<td></td>
<td>Gripper: increase holding force</td>
</tr>
<tr>
<td>Release the left mouse button</td>
<td>Suction cup: the air pump is powered off</td>
</tr>
<tr>
<td></td>
<td>Gripper: open</td>
</tr>
<tr>
<td>Right-click the mouse button</td>
<td>Gripper: close</td>
</tr>
</tbody>
</table>

**Step 4**  Press and hold the left mouse button to control the air pump to suck air to move the mouse to drag the robotic arm to take the cube to another position, such as point B, and release the left mouse button, and the air pump stops working to drop the cube here.

**Step 5**  Press V or ESC to disable the mouse control.

**5.9  Operating 3D Printing**
After installing 3D printing kit, you can import 3D module into the 3D printing software for 3D printing. Figure 5.118 shows the 3D printing process.

![Diagram](image)

Figure 5.118 3D printing process

During 3D printing, the 3D printing control software is required. You can use **Reptier Host** or **Cura** software for 3D printing.

- **Reptier-Host**: Reptier-Host can slice with the third party slicing (such as CuraEngine, Slic3r, etc), check and modify **G-Code**, control 3D printing manually. More parameter settings make **Reptier-Host** very flexible.
- **Cura**: The slicing of **Cura** is fast and stable. It has strong inclusiveness to 3D model structure and less parameter settings.

⚠️ **NOTICE**

This section uses Windows as an example to describe how to perform 3D printing with **Reptier Host** and **Cura**. For Mac OS, only **Cura** is supported.

### 5.9.1 Installing 3D Printing Kit

3D printing kit contains extruder, hot end, motor cable, filament, and filament holder as shown in Figure 5.119.
Procedure

**Step 1** Press down the lever on the extruder, and push down the filament to the bottom of the hole via the pulley, as shown in Figure 5.120.
Step 2  Connect the end of the PTFE tube to the hot end and push it down to the bottom of the hot end, and connect the other end to the extruder, as shown in

![Figure 5.121 Connect extruder and hot end](image)

Step 3  Insert the filament into the PTFE tube and push it down to the bottom of the hot end.

⚠️ NOTICE

Please make sure that the PTFE tube has been pushed down to the bottom of the hot end. Otherwise, it will cause abnormal discharge.
Step 4  Fix the hot end on the Dobot Magician with clamp fixing screw, as shown in Figure 5.122.

![Fix hot end](image)

Figure 5.122  Fix hot end

Step 5  Insert the heating cable to the interface 4 on the Forearm, the fan cable to the interface 5 and the thermistor cable to the interface 6, as shown in Figure 5.123.
Step 6  Connect the extruder to the Stepper1 interface on the back of the base with motor cable, as shown in Figure 5.124.

Figure 5.123  Connect hot end to the Forearm

Figure 5.124  Connect with extruder
Step 7  Place the filament and the extruder to the filament holder, as shown in Figure 5.125.

Figure 5.125  Place filament and extruder to the Filament holder

5.9.2  Operating Repetier Host

Repetier Host has been built into DobotStudio. After burning 3D printing firmware, the Repetier Host page will be displayed automatically.

Prerequisites

- The 3D printing model has been prepared.
- The printing platform has been prepared and please place it in the workspace of the Dobot Magician.
- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully (Only USB connection is supported).
- The 3D printing kit has been installed.

5.9.2.1  Burning Firmware

Procedure

Step 1  Click 3DPrinter on the DobotStudio page.

The 3D Printing FM page is displayed, as shown in Figure 5.126.
Figure 5.126  Burn firmware

**Step 2**  Click **Confirm** to start burning 3D printing firmware.

After burning 3D printing firmware, the **Repetier Host** page is displayed automatically, as shown in Figure 5.127.

If the LED indicator on the base turns red, it indicates that the connection of the 3D printing kit is abnormal.

⚠️ **WARNING**

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid machine damage.
5.9.2.2 Performing 3D Printing

Procedure

Step 1 Set printing parameters.

- Printing parameters only need to be set for the first time.
  1. Click Printer Settings on the top right corner of the Repetier Host page. The Printer Settings page is displayed.
  2. Set the corresponding parameters on the Connection tab as shown in the red box of Figure 5.129. The other parameters are set by default.

NOTICE

If the current firmware is set for 3D printing when operating 3D printing, you can click Connect directly on the DobotStudio page. And then Click OK on the Select tool page to switch to Repetier Host, as shown in Figure 5.128.
3. Click **Apply**.

4. Unselect the corresponding options on the **Printer** tab as shown in the red box of Figure 5.130 and the other parameters are set by default. Then, click **Apply**.
5. Set the corresponding parameters on the **Extruder** tab as shown in the red box of Figure 5.131, the other parameters are set by default. Then, Click **Apply**.
6. Set the corresponding parameters on the **Printer Shape** tab as shown in the red box of Figure 5.132, the other parameters are set by default. Then, Click **Apply**.
Figure 5.132   Printer shape settings

7. Click **OK**

**Step 2**   Click **Connect** on the **Repetier Host** page to connect Dobot Magician. After the connection is successful, the current heating temperature will be shown on the below of the **Repetier Host** page, as shown in Figure 5.133.

Figure 5.133   Connect to Dobot Magician
Step 3  Text extruder.

Before printing, you need to test the extruder to check whether the melted filament flows from the nozzle of the extruder.

The temperature of the extruder should be above 170°C. Dobot Magician will not start 3D printing until the filament is in the melting state. So you need to heat the extruder first.

1. Set the heating temperature to 200°C on the Manual Control tab of the Repetier Host page and click 🔃, as shown in Figure 5.134.

⚠️ DANGER

The heating rod will produce high temperature up to 250°C, please be careful. Do not let children play with it alone. The process needs to be monitored when it is running. After the process is completed, please turn off the equipment promptly.

![Figure 5.134  Heat the extruder](image)

2. Click the extruder feeder when the heating temperature is up to 200°C and feed up to 10mm-30mm, as shown in Figure 5.135.
If the melted filament flows from the nozzle of the extruder, the extruder is working properly.

⚠️ **NOTICE**

If the filament extrusion is in the opposite direction. Please remove the filament, and turn the extruder around, then re-push down the filament.

**Step 4** Adjust the printing space and get the printing coordinates.

⚠️ **NOTE**

During printing, if the distance from Dobot Magician to the printing platform is too large or too small to paste the first layer, it can lead to the nozzle blockage. For increasing the stickiness of the first layer, placing a masking paper on the platform is recommended.

1. Press the **Unlock** key on the Forearm and drag Dobot Magician to make the printing head contact the surface of the masking paper (The distance between the printing head and the surface of the masking paper is the thickness of a sheet of A4 paper), then release the **Unlock** key.

2. Input command **M415** on the **G-Code** command window and press **Enter** to get the current coordinates, as shown in Figure 5.136.
Also, you can press the Key button on the base of the base to get the current coordinates.

![Image](image1.png)

Figure 5.136 Input M415

---

**NOTE**

If you cannot find the G-Code command window, please click EASY to close Easy Mode, as shown in Figure 5.137.

![Image](image2.png)

Figure 5.137 Easy mode

---

**Step 5** Click Load to import the prepared 3D printing model, as shown in Figure 5.138. You can also load 3D printing model which are DobotStudio, the loading path is
Installation directory\DobotStudio\attachment\3dModelStl.

The format of 3D model is STL. You can design 3D model and transform it into STL format.

After importing the model, you can center, zoom, or rotate the model on the **Object Placement** page, as shown in Figure 5.139.
Step 6  Set slicing parameters and slice up.

You need to set the slicing parameters before first printing.

3. Select Slic3r from Slicer on the Slicer tab of the Repetier Host page, and click Configuration, as shown in Figure 5.140.

![Select slicer](image)

**Figure 5.140  Select slicer**

The Slic3r page is displayed, as shown in Figure 5.141.
Figure 5.141  Slic3r page

4. Set the slicing parameters on the Slic3r page.

The 3D printing effect depends on the slice parameters. This topic provides a configuration sample, you can select File > Load Config on the Slic3r page to import it directly for printing.

The path of the configuration sample is Installation directory\DobotStudio\attachment, as shown in Figure 5.142.

Figure 5.142  Configuration sample

Dobot-2.0-Vase.ini is used for printing a thin-walled vase, while Dobot-2.0-ini
is used for the filling, the filling rate is 20%.

5. Save the **Printing Settings**, **Filament Settings** and **Printer Settings** tabs respectively after importing configuration sample, as shown in Figure 5.143.

![Save configuration file](image)

**Figure 5.143  Save configuration file**

6. Click **Slici with Slic3r** on the **Slicer** tab of the **Repetier Host** page, as shown in Figure 5.144.

![Start to slice](image)

**Figure 5.144  Start to slice**

7. Click **Play** on the top left corner of the **Repetier Host** page to print.
Here we choose vase mode to print, and the product after printing as shown in Figure 5.146.
5.9.3 Operating Cura

If you need to use Cura software for 3D printing, please launch the Cura software after burning firmware.

Prerequisites

- Slice software Cura has been installed.
  Please download the recommended version V14.07. The way how to install and use is not described in this topic.
- The 3D printing model has been prepared.
- The printing platform has been prepared and please place it in the workspace of Dobot Magician.
- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully (Only USB connection is supported).
- The 3D printing kit has been installed.

5.9.3.1 Burning Firmware

Procedure

Step 1  Click 3DPrinter on the DobotStudio page.

The 3D Printing FM page is displayed, as shown in Figure 5.147.

![Burn firmware](image)

Figure 5.147  Burn firmware

Step 2  Click Confirm to start burning 3D printing firmware.
After burning 3D printing firmware, if the LED indicator on the base turns red, it indicates that the connection of the 3D printing kit is abnormal.

⚠️ WARNING

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid machine damage.

5.9.3.2 Performing 3D Printing

Procedure

Step 1 Launch Cura software.

Step 2 Set slicing parameters.

1. Select Machine > settings on the Cura page.

   The Machine settings page is displayed.

2. Set the corresponding parameters on the Machine settings and click OK, as shown in Figure 5.148. Table 5.16 lists the values of the parameters that need to be set. The other parameters are set by default.

![Figure 5.148 Parameters setting](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum width</td>
<td>The maximum width please set to 80mm</td>
</tr>
<tr>
<td>Maximum depth</td>
<td>The maximum with please set to 80mm</td>
</tr>
<tr>
<td>Maximum height</td>
<td>The maximum height Please set to 150mm</td>
</tr>
<tr>
<td>Machine center 0,0</td>
<td>Machine center, please select it</td>
</tr>
</tbody>
</table>

Table 5.16  3D printing parameters description
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GCode Flavor</td>
<td>The style of GCode</td>
</tr>
<tr>
<td></td>
<td>Please select <strong>RepRap Marlin/Sprinter</strong></td>
</tr>
<tr>
<td>Build area shape</td>
<td>Build the area shape</td>
</tr>
<tr>
<td></td>
<td>Please select <strong>Circular</strong></td>
</tr>
<tr>
<td>Serial port</td>
<td>Serial port</td>
</tr>
<tr>
<td></td>
<td>Please select the corresponding serial port</td>
</tr>
<tr>
<td>Baudrate</td>
<td>Baud rate</td>
</tr>
<tr>
<td></td>
<td>Please set to 115200</td>
</tr>
</tbody>
</table>

3. Set slice parameters, and select **File > Open Profile** to import these parameters, as shown in Figure 5.149.

![Figure 5.149 Import slice parameters](image)

The 3D printing effect depends on the slice parameters. This topic provides a configuration sample, you can import it directly for printing.

The path of the configuration sample is **Installation directory\DobotStudio attachment**, as shown in Figure 5.150.
Dobot-2.0-Vase-Cura.ini is used for printing a thin-walled vase, while Dobot-2.0-Cura.ini is used for the filling, the filling rate is 20%.

4. Click 【】 the Open 3D model page is displayed, and select the 3D printing model prepared.

The format of 3D model is STL. You can design 3D model and transform it into STL format.

After importing the model, click the model itself, you can center, zoom or rotate, and so on, as shown in Figure 5.151.

5. Click 【】 to connect with Dobot Magician.
The printing window is displayed and the current printing temperature is shown on the top corner of the window, as shown in Figure 5.152.

![Printing window](image)

**Figure 5.152 Printing window**

6. Set **Temperature** to **200** and press down **Enter** to heat the extruder.

   The temperature of the extruder should be above 170°C. Dobot Magician will not start 3D printing until the filament is in the melting state. So you need to heat the extruder first.

⚠️ **DANGER**

   The heating rod will produce high temperature up to 250°C, please be careful. Do not let children play with it alone. The process needs to be monitored when it is running. After the process is completed, please turn off the equipment promptly.

**Step 3** Test the extruder.

   Before printing, you need to test the extruder to check whether the melted filament flows from the nozzle of the extruder.

   Click the feedstock extruder or click the given stepper, such as **10, 1, 0.1** (10 is recommended) on the **Operational** page and feed up to 10mm-30mm, as shown in Figure 5.153.
If the melted filament flows from the nozzle of the extruder, the extruder is working properly.

⚠️ NOTICE

If the filament extrusion is in the opposite direction, please remove the filament, and turn the extruder around, then re-push down the filament.

**Step 4** Adjust the printing space and get printing coordinates.

⚠️ NOTE

During printing, if the distance from Dobot Magician to the printing platform is too large or too small to paste the first layer, it can lead to the nozzle blockage. For increasing the stickiness of the first layer, placing a masking paper on the platform is recommende.

1. Press the **Unlock** key on the Forearm and drag Dobot Magician to make the printing head contact the surface of the masking paper(The distance between the printing head and the surface of the masking paper is the thickness of a sheet of A4 paper), then release the **Unlock** key.
2. Input command **M415** on the lower right of the **Operational** page to get the current coordinates, as shown in Figure 5.154.

   Also, you can press the **Key** button on the base of the base to get the current coordinates.
Step 5  
Click **Print**, Dobot Magician moves to the printing origin (System setting) and starts printing.

5.10 Calibration

5.10.1 Base Calibration

The base Encoder has been calibrated before being shipped out. Generally, the J1-coordinate is 0° after homing, where the homing point is the system default. Namely, the Forearm is located at the middle in front of the base.

If the J1-coordinate is not 0° (error range: 1° -3°) after homing, you need to re-calibrate the base Encoder.

**Prerequisites**

- The writing and drawing kit has been installed. For details, please see 5.4.1 *Installing a Writing and drawing kit*.
- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully.
- The sensor calibration board has been prepared.

**Procedure**

**Step 1**  Place the Dobot Magician at the right position on the sensor calibration board, as shown in Figure 5.155.
Step 2 (Optional) Set the homing point and make the nib contact the surface of the calibration board.

This step is used for observing the nib position on the calibration board when moving J1-axis in Step 5, to improve calibration accuracy.

1. Click **Teaching&Playback** on the DobotStudio page.

   The **Teaching&Playback** page is displayed.

2. Press the **Unlock** key on the Forearm and drag Dobot Magician to make the nib contact the surface of the calibration board, then release the **Unlock** key.

   The coordinates of this point will be displayed on the **Teaching&Playback** page.

3. Select this point and right-click **SetHome**, as shown in Figure 5.156.

![Figure 5.156 Set homing position](image-url)
**Step 3**  Click Setting > Base Calibration on the DobotStudio page. The Base Calibration page is displayed.

**Step 4**  Click Next on the Base Calibration page.

Dobot will start homing. Please ensure that there are no obstacles in the workspace during homing.

**Step 5**  Click +J1 or -J1 to make the nib at a point on the line between A3 and B3 on the calibration board, as shown in Figure 5.157 and Figure 5.158.

If the speed is too fast when moving J1-axis, you can drag Speed slider to adjust speed.

![Base Calibration](image)

**Figure 5.157**  Move J1-axis
Step 6  Click **Calibration** to start calibrating the base Encoder.

You can check the J1-coordinate on the **Operation Panel** page, as shown in Figure 5.159.
The angle sensors of the Forearm and Rear Arm have been calibrated before being shipped out. Generally, the Z-coordinate will remain the same when moving Dobot Magician in the same horizontal plane. If changed, you need to recalibrate the angle sensors by manual levelling or auto levelling to improve the positioning accuracy.

- **Manual Levelling**: It is more accurate to calibrate manually with DobotStudio, sensor calibration board, and writing and drawing kit, which is suitable for the application scenarios with high requirements for absolute positioning accuracy.
- **Auto Levelling**: It is simple and quick to calibrate automatically with DobotStudio and auto-levelling tool, which is suitable for the application scenarios without high requirements for absolute positioning accuracy, such as writing and drawing, 3D printing.

### 5.10.2.1 Manual Levelling

**Prerequisites**
Dobot Magician has been powered on.
Dobot Magician has been connected to DobotStudio successfully.
The sensor calibration board has been prepared.

**Procedure**

**Step 1** Place the Dobot Magician at the right position on the sensor calibration board, as shown in Figure 5.160.

![Figure 5.160 Location of Dobot Magician](image)

**Step 2** Click Setting > Manual Levelling on the DobotStudio page. The Manual Levelling page is displayed.

**Step 3** Click Next on the Manual Levelling page.
Dobot Magician will finish the auto-compensation of the angle sensor coefficients of the Forearm and Rear Arm move according to the system settings. The result is as shown in Figure 5.161.

⚠️ **NOTICE**

Please remove all end-effectors from Dobot Magician before calibrating
**Step 4** Click Next and set **Angle Precision, Distance Precision, Result Range**.

In this step, please keep the default values, as shown in Figure 5.162.

**Step 5** Click Next and follow the instructions on the Manual Levelling page to move Dobot Magician to the first calibrated point. If the calibrated point is A3 on the Calibration board.
1. Install the writing and drawing kit. For details, please see 5.4.1 Installing a Writing and drawing kit.

2. Press the Unlock key on the Forearm and drag Dobot Magician to make the nib near the A3 point on the calibration board, then release the Unlock key.

3. Click coordinate buttons on the Manual Levelling page (as shown in Figure 5.163) to make the nib align to the center of A3 point on the calibration board, as shown in Figure 5.164.

   If the speed is too fast when clicking coordinate buttons, you can drag Speed slider to adjust speed.

![Figure 5.163 Fine-tune page]
**Step 6**  Click **Next** and follow the instructions on the **Manual Levelling** page (as shown in Figure 5.165) to move Dobot Magician to make the nib in the center of the second calibrated point. If the calibrated point is **B3** on the calibration board, as shown in Figure 5.166.

⚠️ **NOTICE**

Please DO NOT drag Dobot Magician in this step, to avoid manual levelling failure. If the speed is too fast when clicking coordinate buttons, you can drag **Speed** slider to adjust speed.
Step 7 Click Next and set the distance between the two calibrated points, as shown in Figure 5.167.
The distance between the two calibrated points on the Calibration board is 80mm, so please keep the default value in this step.
Step 8  
Click **Next** to start calibrating.

The result is shown as Figure 5.168.

5.10.2.2 **Auto Levelling**

**Prerequisites**
• Dobot Magician has been connected to a PC via USB cable.
• Dobot Magician has been connected to the power adapter.
• The auto-levelling tool has been obtained, as shown in Figure 5.169.

![Auto-levelling tool](image)

**Figure 5.169** Auto-levelling tool

**Procedure**

**Step 1** Place Dobot Magician on the flat platform.

⚠️ **NOTICE**

Please ensure that the platform is flat. Or, the auto levelling will be failed.

**Step 2** Fix the auto-levelling tool on the Dobot Magician with clamp fixing screw, as shown in Figure 5.170.
Figure 5.170  Fix auto-levelling tool

**Step 3** Insert the cable of the auto-levelling tool to the interface 2 on the Forearm, as shown in Figure 5.171.

Figure 5.171  Insert the cable of the auto-levelling tool
**Step 4**  Power on Dobot Magician and connect it to DobotStudio.

**Step 5**  Click Setting > **Auto Levelling** on the DobotStudio page.

The Auto Levelling page is displayed, as shown in Figure 5.172.

⚠️ **NOTICE**

Please ensure that there are no obstacles in the workspace during auto levelling.

![Figure 5.172 Auto levelling page](image)

---

**Step 6**  Click **Start** on the **Auto Levelling** page.

Dobot Magician starts auto levelling. The levelling process will takes about 2 minutes. The result is shown as Figure 5.173.

⚠️ **NOTE**

If the auto levelling is failed, please check if the platform is flat and try again.
5.10.3 Homing

Dobot Magician has been calibrated before being shipped out. If the Dobot Magician has been hit or the motor has lost step, leading data abnormal, you need to operate homing to improve the positioning accuracy.

Prerequisites

- Dobot Magician has been powered on.
- Dobot Magician has been connected to Dobot Studio successfully.

Procedure

Click **Home** on the Dobot Studio page, as shown in Figure 5.174.

⚠️ **NOTICE**

- Please remove the end-effector from the Dobot Magician before homing.
- Please ensure that there are no obstacles in the workspace during homing.

Dobot Magician will rotate clockwise to the limited position and then return to the default homing point automatically and the LED indicator on the base turns blue and is blinking. After the homing is successful, there is a beep sound and the LED indicator turns green.
Also, the homing point can be use-defined, you can select a saved point on the Teachong&Playback page and right-click SetHome to set this saved point as the homing point, as shown in Figure 5.175.

![Figure 5.175: Set homing point](image)

### 5.11 Connecting with WIFI Kit

You can connect Dobot Magician to a PC via WIFI kit without USB cable, making Dobot Magician and PC in the same WLAN. Figure 5.176 shows the WIFI kit.

![Figure 5.176: WIFI kit](image)

**Prerequisites**

- Dobot Magician has been connected to a PC via USB cable.
- Dobot Magician has been connected to the power adapter.
The WIFI name and password have been obtained and must be the same as that of PC.

Procedure

Step 1 Connect the WIFI kit to the UART interface on the base, as shown in Figure 5.177.

![Connect with WIFI kit](image)

Figure 5.177 Connect with WIFI kit

⚠️ NOTICE
Please turn off the Dobot Magician completely first before connecting or disconnecting external equipment. Or, it causes serious damage to your device.

Step 2 Press down the power button to turn on the Dobot Magician.
After turning on, there are two short beep sounds and the blue LED indicator on the WIFI module is on.

Step 3 Select the corresponding serial port from the serial drop-down list, and click Connect.

Step 4 Click Setting > Wi-Fi.
The Set Dobot Wi-Fi page is displayed.

Step 5 Set the related parameters on the Set Dobot Wi-Fi page.
In this topic, please select Dynamic Host Configuration Protocol (DHCP) and set SSID and Password to obtain the IP address of Dobot Magician, as shown in Figure 5.178.
If you unselect Dynamic Host Configuration Protocol (DHCP), you need to set IP address, Netmask, Gateway. For details, please see Table 5.17.
Figure 5.178  Set WIFI

Table 5.17  Parameter description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSID</td>
<td>Set WIFI name</td>
</tr>
<tr>
<td></td>
<td>The WIFI name and password have been obtained and must be the same as that of PC</td>
</tr>
<tr>
<td>Password</td>
<td>Set WIFI password</td>
</tr>
<tr>
<td>Dynamic Host Configuration Protocol (DHCP)</td>
<td>Whether to select DHCP</td>
</tr>
<tr>
<td></td>
<td>Yes: Only set SSID and Password</td>
</tr>
<tr>
<td></td>
<td>No: Only set IPAddress, Netmask and Gateway</td>
</tr>
<tr>
<td>IPAddress</td>
<td>Set the IP address of Dobot Magician. The IP address of Dobot Magician and the PC must be in the same WLAN without conflict.</td>
</tr>
<tr>
<td>Netmask</td>
<td>Set subnet mask</td>
</tr>
<tr>
<td>Gateway</td>
<td>Set gateway</td>
</tr>
<tr>
<td>DNS</td>
<td>Set DNS</td>
</tr>
</tbody>
</table>

**Step 6**  Click **OK**.
About 5 seconds later, the green LED indicator on the WIFI module is on, indicating that the Dobot Magician has been connected with WLAN, as shown in Figure 5.179.

![Figure 5.179 Status of LED indicator](image)

**Step 7** Click **Disconnect** on the left pane of the DobotStudio page.

**Step 8** After 2 seconds later, select the IP address from the drop-down list on the upper left pane of the DobotStudio page and click **Connect**, as shown in Figure 5.180.

![Figure 5.180 IP address of Dobot Magician](image)

After the connection is successful, you can control Dobot Magician without USB cable.

### 5.12 Connecting with Bluetooth Kit

Dobot Magician can be connected to smart phone with Bluetooth. Figure 5.181 shows the Bluetooth kit. Please download the matched DobotStudio APP from the website [https://cn.dobot.cc/downloadcenter.html?sub_cat=69#sub-download](https://cn.dobot.cc/downloadcenter.html?sub_cat=69#sub-download).
Prerequisites

- Dobot Magician has been connected to the power adapter.
- The DobotStudio APP has been downloaded.

Procedure

Step 1  Connect the Bluetooth kit to the UART interface on the base, as shown in Figure 5.182.
Figure 5.182  Connect with Bluetooth kit

⚠️ NOTICE

Please turn off the Dobot Magician completely first before connecting or disconnecting external equipment. Or, it causes serious damage to your device.

**Step 2** Press down the power button to turn on the Dobot Magician.
After turning on, there are three short beep sounds and the blue LED indicator on the Bluetooth module is on and the green one is blinking.
Turn on the Bluetooth and launch DobotStudio APP on your phone. And click **Connect** to connect with Dobot Magician.
This topic only describes how to connect Bluetooth kit. For details how to operate Dobot Magician with DobotStudio APP, please see [https://www.youtube.com/watch?v=kyeXwuf17IY](https://www.youtube.com/watch?v=kyeXwuf17IY).

### 5.13 Operating Blockly

Blockly is a programming platform based on Google Blockly. You can program through the puzzle format, which is straightforward and easy to understand.

**Prerequisites**
Dobot Magician has been powered on.
Dobot Magician has been connected to DobotStudio successfully.

**Procedure**

**Step 1** Click **Blockly** on the DobotStudio page. The **Blockly** page is displayed.

**Step 2** Drag the blockly module on the left pane of the **Blockly** page to program, as shown in Figure 5.183.

![Blockly graphic programming](image)

**Figure 5.183** Blockly graphic programming

Table 5.18 lists the description of blockly module.

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The selection area of blockly module, including logistic, loop, math, and Dobot API. You can program by dragging them to the window.</td>
</tr>
<tr>
<td>2</td>
<td>The window of blockly programming</td>
</tr>
<tr>
<td>3</td>
<td>The running log of Dobot Magician</td>
</tr>
<tr>
<td>4</td>
<td>The corresponding codes of the blockly module on the programming window</td>
</tr>
</tbody>
</table>

The demo in Figure 5.183 is described as follows.

1. Set the end-effector as **Gripper**.
2. Set the loop number as 3 and make the Z-axis move back and forth 3 times.
3. Set the pause time as 3.

**Step 3** Click **Save** on the **Blockly** page.

The Saving Blockly file page is displayed.

**Step 4** Input the use-defined name and the saving path, and click **Save**. The default path of
the programing file is `Installation directory/DobotStudio/config/ststore`. Please replace the path based on site requirements.

**Step 5** Click **Start** on the **Blockly** page, and Dobot Magician will move according to the program.

### 5.14 Scripting

You can control Dobot Magician over scripting. Dobot Magician supports various API, such as velocity/acceleration setting, motion mode setting, and I/O configuration, which uses Python language for secondary development. For details about the Dobot Magician API interface and function description, please see *Dobot Magician API Description*.

The download path is [https://www.dobot.cc/downloadcenter.html?sub_cat=72#sub-download](https://www.dobot.cc/downloadcenter.html?sub_cat=72#sub-download).

#### Prerequisites

- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully.

#### Procedure

**Step 1** Click **Script** on the **DobotStudio** page. The **Script** page is displayed.

**Step 2** Write a script.

You can call the interface by double-clicking on the left pane of the **Script** page, the corresponding interface will be displayed on the middle pane, as shown in Figure 5.184. You can also click ![faq_icon](https://example.com/faq_icon.png) icon of the corresponding interface to view the way how to set the parameters. The scripting examples (including Jog, PTP, and Pallet) can refer to `Installation directory/DobotStudio/config/ststore/`.

![script_interface](https://example.com/script_interface.png)

**Figure 5.184** Write a script
Step 3 Click Save on the Script page.
The Saving Scrip File page is displayed.

Step 4 Input the use-defined name and the saving path, and click Save.
The default path of the script is Installation directory/DobotStudio/config/ststore.
Please replace the path based on site requirements.

Step 5 Click Start, and Dobot Magician will move according to the script file.
The running log will be displayed on the lower pane of the Script page for checking.

5.15 Operating Stick Controller Kit

Dobot Magician can be controlled by stick controller kit without DobotStudio. Figure 5.185 shows the stick controller kit. From left to right: Stick controller, USB Host module, USB cable (used for charging stick controller), Transceiver.

![Stick controller kit](image)

Figure 5.185 Stick controller kit

Prerequisites
- Dobot Magician has been connected to a PC over USB cable.
- Dobot Magician has been connected to the power adapter.

Procedure

Step 1 Connect the transceiver to the USB module.

Step 2 Connect the USB Host module to the UART interface on the base, as shown in Figure 5.186.
Step 3  Press down the power button to turn on the Dobot Magician. The blue LED indicator on the USB Host module is on. After turning on, there are four short beep sounds and the green one is on.

⚠️ **NOTICE**

Please turn off the Dobot Magician completely first before connecting or disconnecting external equipment. Or, it causes serious damage to your device.

Step 4  Press down the power button on the stick controller, as shown in Figure 5.187. The red LED indicator on the middle of the stick controller is blinking, indicating that the Dobot Magician can be controlled by the stick controller.
Table 5.19 lists the functions of buttons on the stick controller.

Table 5.19  Button function

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power button</td>
<td>Turn on stick controller</td>
</tr>
<tr>
<td></td>
<td>The stick controller will turn off automatically</td>
</tr>
<tr>
<td>LT</td>
<td>Turn on the peripheral motor</td>
</tr>
<tr>
<td>RT</td>
<td>Turn off the peripheral motor</td>
</tr>
<tr>
<td>RB</td>
<td>Switch to Cartesian coordinate system mode</td>
</tr>
<tr>
<td>LB</td>
<td>Switch to Joint coordinate system mode</td>
</tr>
<tr>
<td>X</td>
<td>Control the outtake of the air pump</td>
</tr>
<tr>
<td>Y</td>
<td>Control the intake of the air pump</td>
</tr>
<tr>
<td>B</td>
<td>Turn off the air pump</td>
</tr>
<tr>
<td>Left stick: Front/back</td>
<td>• Cartesian coordinate system mode: Dobot Magician moves along X-axis in the positive/negative direction</td>
</tr>
<tr>
<td></td>
<td>• Joint coordinate system mode: Dobot Magician rotates along J1-axis in the positive/negative direction</td>
</tr>
<tr>
<td>Left stick: Left/right</td>
<td>• Cartesian coordinate system mode: Dobot Magician moves along Y-axis in the</td>
</tr>
</tbody>
</table>
### 5.16 Operating Sliding Rail

When the workspace of Dobot Magician is not enough, you can extend it with the sliding kit to do large-scale tasks, such as long-distance picking and placing, a large range of writing and so on. Figure 5.188 shows the sliding rail kit and Table 5.20 lists its description.
Table 5.20 Sliding rail kit description

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tool kit</td>
</tr>
<tr>
<td>2</td>
<td>Screws</td>
</tr>
<tr>
<td>3</td>
<td>Plate a</td>
</tr>
<tr>
<td>4</td>
<td>Plate e</td>
</tr>
<tr>
<td>5</td>
<td>Sliding rail (with wire set and plate b)</td>
</tr>
</tbody>
</table>

5.16.1 Installing sliding rail

Procedure

Step 1 Mount Dobot Magician on the plate a with four M3*10 countersunk head cap screws (The counter bore of plate a is outwards), as shown in Figure 5.189.
Step 2  Fix the plate a (with Dobot Magician) on the plate b with three M3*8 hexagon socket head cap screws. Please make the back of the base of Dobot Magician towards the rabbet on the plate b, as shown in Figure 5.190.
Step 3  Connect the end of the wire set to the plate b with a M3*6 countersunk head hexagon screw, as shown in Figure 5.191.

Step 4  (Optional) Fix plate c. This step is only needed when using air pump for picking and placing or other tasks.
1. Fix the plate c on the plate a with two M3*8 hexagon socket head cap screws, as shown in Figure 5.192.

![Figure 5.192 Fix plate c](image)

2. Fix the air pump on the plate c, as shown in Figure 5.193. And connect the air pump to Dobot Magician. For details, please see 5.2.1 Installing a Suction Cup Kit.

![Figure 5.193 Fix air pump](image)

**Step 5** Connect the interfaces on the end of the wire set to Dobot Magician, as shown in Figure 5.194.
Step 6  Connect the interfaces on the other end of the wire set to the power adaptor, USB interface of PC, motor interface and homing interface of the sliding rail respectively. Figure 5.195 shows the interfaces on the other end of the wire set.

Figure 5.195  Interfaces on the other end of the wire set

Figure 5.196 shows the connection between the sliding rail and the wire set.
5.16.2 Sliding Rail Parameter Description

Table 5.21  Sliding rail parameter description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum payload</td>
<td>5kg</td>
</tr>
<tr>
<td>Maximum Distance</td>
<td>1000mm</td>
</tr>
<tr>
<td>Maximum speed</td>
<td>150mm/s</td>
</tr>
<tr>
<td>Maximum acceleration</td>
<td>150mm/s²</td>
</tr>
<tr>
<td>Repeated positioning accuracy</td>
<td>0.01mm</td>
</tr>
<tr>
<td>Absolute positioning accuracy</td>
<td>0.25mm</td>
</tr>
</tbody>
</table>

5.16.3 Demo Description

This topic describes how to use the V2 version of sliding rail for writing.

Prerequisites

- The sliding rail has been installed and connected to the Dobot Magician.
- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully.
- The writing and drawing kit has been installed. For details, please see 5.4.1 Installing
a Writing and drawing kit.

Procedure

Step 1 Select **New Linear Rail** on the **Setting > General** page of DobotStudio and Click **OK**, as shown in Figure 5.197.

![Select New Linear Rail](image)

Figure 5.197 Select New Linear Rail

Step 2 Click **LinerRail** on the DobotStudio page.
Now, you can click **L+**, **L-** to make Dobot Magician move to the left or right.

Step 3 Click **Home** on the DobotStudio page.
The sliding block moves to its homing point and then Dobot Magician rotates back to its homing point.

Step 4 (Optional) Save points on the **Teaching&Playback** page, so as to trigger them for some operations when Dobot Magician moves on the sliding rail, such as inking brush during writing.

For details about teaching and playback, please see 5.2 Performing Teaching & Playback Tasks.

1. Click **Teaching&Playback** on the DobotStudio page.
The **Teaching&Playback** page is displayed.
2. Save points on the **Teaching&Playback** page.
The saved points list is as shown in Figure 5.198.

![Figure 5.198 Save points](image)

*L* indicates the position where Dobot Magician is located on the sliding rail, and the speed and acceleration can be set on the **Setting > Playback** page.

3. Click **Exit** to close **Teaching&Playback** page.

**Step 5**  
Click **Write&Draw** on the DobotStudio page.

The **Write&Draw** page is displayed, as shown in Figure 5.199.

For details about writing and drawing, please see *5.4 Writing and Drawing*.

![Figure 5.199 Write&Draw page](image)

The rectangle in Figure 5.199 is the workspace of Dobot Magician (with sliding rail).

**Step 6**  
Input text on the **Input Texts** pane and click **OK**, as shown in Figure 5.200.

If the text is **Magician**.
Step 7  (Optional) Right-click **Add a playback trigger** on the Write&Draw page to set trigger points, as shown in Figure 5.201.

If the trigger points are set after the first letter **a** and the letter **c**, as shown in Figure 5.202.
Step 8  Click Start.

Dobot Magician starts writing. Take the first trigger point as an example, after writing the first letter a, the saved points list on the Teaching&Playback page is triggered, and Dobot Magician moves to the set position to perform the related operations according to the saved points list. Then, Dobot Magician continues to write.

5.17 Multiplexed I/O Demo

The addresses of the I/O interfaces in Dobot Magician are unified. Most of I/O interfaces have multiple functions. For details, please see 4.3 Multiplexed I/O Interface Description.

You can set I/O interfaces on the advanced Teaching&Playback page to control the peripheral equipment, as shown in Figure 5.203.

Now, demos of level output, level input, and PWM output are given below.
5.17.1 Level Output

Normally, air pump can be controlled by the I/O interfaces. The I/O 11 controls its intake (High level) and outtake (Low level) and the I/O 16 controls its start-stop. Table 5.22 lists the multiplexed descriptions of I/O 11 and I/O 16.

<table>
<thead>
<tr>
<th>I/O addressing</th>
<th>Voltage</th>
<th>Level Output</th>
<th>PWM</th>
<th>Level Input</th>
<th>ADC</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>3.3V</td>
<td>√</td>
<td>√</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>16</td>
<td>12V</td>
<td>√</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

The I/O 11 and I/O 16 are located at the peripheral interface of the base, as shown in Figure 5.204.

Prerequisites

- The air pump has been connected to Dobot Magician. For details, please see 5.2.1 Installing a Suction Cup Kit.
- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully.

Procedure

Step 1 Select **Pen** from the end-effector drop-down list on the DobotStudio page, as shown in Figure 5.205.
**NOTICE**

Normally, if **SuctionCup** or **Gripper** is selected from the end-effector drop-down list after the air pump has been connected, the air pump will be controlled by the system. In this topic, we use I/O interfaces to control the air pump, so **SuctionCup** and **Gripper** cannot be selected, to avoid conflict.

**Step 2**  Click **Easy** icon on the **Teaching&Playback** page, as shown in Figure 5.206.

![Image](image_url)

**Figure 5.206  Switch advanced function**

**Step 3**  Select **IO_11, IO_16** and their corresponding **Value** on the **Output** pane, and click **+Point**.

“The saved point is displayed on the **Teaching&Playback** page, as shown in Figure 5.207.

**NOTE**

If the intake is not obvious, please modify **PauseTime** of this saved point.
Step 4 Select this point and click StepRun.
The air pump is humming with intake.

Step 5 Select IO_11, IO_16 and the corresponding Value of IO_16 on the Output pane, and click + Point.
The saved point is displayed on the Teaching & Playback page, as shown in Figure 5.208.

Step 6 Select this point and click StepRun.
The air pump is humming with outtake.

5.17.2 Level Input
This topic also takes I/O 12 as an example.
Table 5.23  Multiplexed I/O description

<table>
<thead>
<tr>
<th>I/O addressing</th>
<th>Voltage</th>
<th>Level Output</th>
<th>PWM</th>
<th>Level Input</th>
<th>ADC</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>3.3V</td>
<td>-</td>
<td>-</td>
<td>√</td>
<td>-</td>
</tr>
</tbody>
</table>

Prerequisites

- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully.
- The saved points list has been existed on the Teaching&Playback page.

Procedure

Step 1  Click icon on the Teaching&Playback page, as shown in Figure 5.209.

![Figure 5.209  Switch advanced function](image)

Step 2  Select a saved point on the Teaching&Playback page.

Step 3  Select EIO11_Input on the Trigger pane, and set Condition and its Value. Here, Value only can be set to 0 or 1. 1: High level; 0: Low level.

Step 4  Click ADD, as shown in Figure 5.210.

![Figure 5.210  Saved point](image)
5.17.3 PWM OUTPUT

This topic also takes I/O 11 as an example.

<table>
<thead>
<tr>
<th>I/O addressing</th>
<th>Voltage</th>
<th>Level Output</th>
<th>PWM</th>
<th>Level Input</th>
<th>ADC</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>3.3V</td>
<td>✓</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Prerequisites**

- Dobot Magician has been powered on.
- Dobot Magician has been connected to DobotStudio successfully.

**Procedure**

**Step 1** Click the **Easy** icon on the **Teaching&Playback** page, as shown in Figure 5.211.

![Figure 5.211 Switch advanced function](image)

**Step 2** Select **IO_11** on the Output pane, and click **Point** as shown in Figure 5.212.

![Figure 5.212 Saved point](image)

**Step 3** Double-click **EIO11** cell and select **…** from the drop-down list.

The **EIO Setting** page is displayed, as shown in Figure 5.213.
Step 4 Set **Frequency** (Unit: KHZ; Value range: 10HZ-1MHZ) and **DutyRatio** (0%-100%) on the EIO Setting page.
Appendix A Dobot Magician Homing Operation

Homing Procedure:
1. Turn on Dobot Magician, wait for about 20 seconds after green light is on, and then click Home on Dobot Studio page to make Dobot Magician execute homing operation.
2. Blue light will flash during homing, and Dobot Magician will execute homing operation. Do not operate the Dobot until the green light is on.
3. Save points and download them to Dobot Magician. Click OK to wait downloading finished.

4. Disconnect USB cable and press down Key button to execute offline mode.

Playback Procedure:
If there are some points saved in Dobot Magician before, you can turn on Dobot Magician directly, wait for about 20 seconds after green light is on, press down Key button for long time to execute homing operation, and then press down Key button again to execute offline mode.